PAGE  

В.Котляров, Т.Коликова

ПРАКТИКУМ ПО КУРСУ

«ОСНОВЫ СОВРЕМЕННОГО ТЕСТИРОВАНИЯ ПРОГРАММНОГО ОБЕСПЕЧЕНИЯ НА C#»

Санкт-Петербург

2003

@В.П.Котляров

АННОТАЦИЯ

В.Котляров, Т.Коликова. ПРАКТИКУМ ПО КУРСУ “ОСНОВЫ СОВРЕМЕННОГО ТЕСТИРОВАНИЯ ПРОГРАММНОГО ОБЕСПЕЧЕНИЯ, РАЗРАБОТАННОГО НА С#”, Учебное пособие, Санкт-Петербург, 2003, 137с.

Настоящий практикум представляет собой вторую часть курса, посвященного проблемам современного тестирования.   Задачей практикума является подготовка тестировщиков программного проекта. 

Данный практикум предназначен для того, чтобы сформировать у студентов навыки тестирования программного обеспечения, на базе применения теории и современных методов тестирования к практическим приложениям. 

Обычно это достаточно легко сделать для простых учебных примеров, однако при тестировании реальных систем этого недостаточно.  Поэтому в качестве тестируемой системы выбрана система с очевидной функциональностью, но с далеко не простой системой требований и критериев, и на ее примере продемонстрировано применение различных подходов к тестированию прикладных систем, что позволяет самостоятельно выполнять задания по аналогии и быстро усваивать материал. Такой подход с методической точки зрения достаточно удачен и обоснован.

Практикум обобщает опыт многолетней  работы учебного центра “Политехник - Моторола” в Санкт-Петербургском государственном политехническом университете. 

Практикум рассчитан на студентов программистских специальностей 220400, 220200, 220300, 351500, а также  на студентов других специальностей, желающих получить знания и навыки, необходимые для работы в области промышленного тестирования программных продуктов. 
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1 Введение

В настоящее время очень актуальной стала проблема подготовки тестировщиков программного обеспечения. Настоящий практикум предназначен для того, чтобы сформировать у студентов навыки тестирования программного обеспечения на базе применения теории и современных методов тестирования к практическим приложениям. Обычно это достаточно легко сделать для простых учебных примеров, для которых смысл проблематики тестирования не ощущается, так как с небольшими приложениями и так все ясно, однако когда дело доходит до тестирования реальных систем, оказывается, что полученных знаний недостаточно.  Необходим опыт работы с большой системой, когда объем проверяемого кода, сложность и детальность требований, а также ответственность за результат приводят к осознанию профессиональных условий работы тестировщика.  

Именно поэтому в качестве тестируемой системы была выбрана система с очевидной функциональностью, но с далеко не простой системой требований и критериев корректности - модель реальной система управления автоматизированным комплексом хранения подшипников. Информация о функционировании выбранной системы представлена примерно тем же способом и в виде тех же документов, с какими сталкивается тестировщик по окончании фазы дизайна и в начале фазы разработки тестов – это «Спецификация требований» (Requirement Specification) и «Высокоуровневый дизайн» (High Level Design). На этой основе изучаются и самостоятельно разрабатываются тесты (test case), тестовые наборы (test suite) и программы тестирования, использующиеся как при ручном, так и при автоматизированном подходе к тестированию. 

Применение различных подходов к тестированию прикладной системы демонстрируется на базе готовых и подробно разобранных примеров. Это позволяет самостоятельно выполнять задания по аналогии и быстро усваивать материал. Такой подход с методической точки зрения достаточно удачен и обоснован.

Материал практикума изучается в следующем порядке.
Начинаем с изучения функциональности тестируемой системы и ее окружения по краткому описанию раздела 1 и документам приложения: «Спецификации требований» и «Высокоуровневому дизайну».

Изучаем факторы, влияющие на планирование деятельности тестировщика. 

Изучаем особенности модульного тестирования объектно-ориентированной программы на примере тестирования классов.  

Освоение материала контролируется выполнением самостоятельного задания №1.

Изучаем особенности интеграционного тестирования – способы описания тестов и тестовых процедур для программного комплекса, собранного из модульно оттестированных компонентов.

Освоение материала контролируется выполнением самостоятельного задания №2.

Изучаем  особенности процесса системного тестирования.

Освоение материала  контролируется выполнением самостоятельного задания №3.

Изучаем  методику ручной разработки тестов

Освоение материала контролируется выполнением самостоятельного задания №4.

Изучаем методику автоматизации разработки и прогона тестов на основе скриптов.

Освоение материала контролируется выполнением самостоятельного задания №5.

Изучаем методику генерации и прогона тестов по формальным описаниям языка Message Sequence Chart (MSC).

Освоение материала контролируется выполнением самостоятельного задания №6.

Изучение различных подходов к тестированию, рассматриваемое на основе одних и тех же тестовых сценариев, дает возможность сравнить их трудоемкость и понять необходимость автоматизации тестирования, как для разработки, так и для прогона тестовых наборов.  

Авторы выражают искреннюю благодарность Московскому отделению Microsoft Corporation, спонсировавшему разработку настоящего пособия, и лично Люцареву В.С., отметившему своевременность и полезность данной работы. 

Предлагаемый вашему вниманию читателей практикум обобщает опыт многолетней  работы учебного центра “Политехник - Моторола” в Санкт-Петербургском государственном политехническом университете. 

Разработка практикума была бы невозможна без самоотверженной работы студентов и аспирантов, выполнивших разработку инструментального средства автоматизации тестирования и проверку всех примеров. Коллектив в составе студентов 4 курса К.Кудряшева, Д.Пескова, М.Даишева, Е.Марченкова и аспирантов Д. Югая и В.Сухомлинова ? был организован в виде программистской бригады и вел разработку по законам создания промышленного проекта.

2 ОПИСАНИЕ ТЕСТИРУЕМОЙ СИСТЕМЫ И ЕЕ ОКРУЖЕНИЯ

Практикум базируется на тестировании модели реальной системы управления автоматизированным комплексом хранения подшипников. Она обеспечивает прием подшипников на склад, сохранение характеристик поступивших подшипников в базе данных (БД), а при поступлении заявки на подшипники вместе с параметрами оси - подбор подходящих подшипников и их выдачу. У каждого из элементов комплекса (склада, терминала подшипника и терминала оси) существует программа низкоуровневого управления, реализованная в виде динамически подключаемой библиотеки (dll), принимающая на вход высокоуровневые команды, и преобразующая их в управляющие воздействия на данный элемент тестируемой системы. Таким образом, есть реальное окружение – аппаратура и dll, которые осуществляют связь с аппаратурой. Система вызывает следующие функции из dll для своих элементов (см. Рис. 2‑1):

GetStoreStat, GetStoreMessage, SendStoreCom (Store.dll) для склада
GetAxlePar (Axle.dll) для терминала оси

GetRollerPar (Bearing.dll) для терминала подшипника
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Рис. 2‑1 Система и ее окружение

Поскольку для тестирования используется модель системы, в ее составе реальное окружение заменено на модельное, обеспечиваемое специальной библиотекой dll-функций окружения.

Тестируемая система реализована как многопоточное приложение. Многопоточность порождает недетерминированность поведения системы во времени. Поэтому при тестировании необходимо учитывать, что возможны различные варианты допустимых временных последовательностей событий системы. Кроме того, совсем не просто точно воспроизвести прогон конкретного теста, когда система содержит много параллельных потоков, так как планировщик операционной системы сам определяет порядок событий. Изменения, вносимые в программы, не связанные с тестируемой системой, могут повлиять на порядок, в котором будут выполняться (воспроизводиться) потоки событий  тестируемой системы. Это может привести к тому, что после выявления и исправления дефекта при проведении повторного тестирования далеко не всегда удастся убедиться в том, что дефект действительно устранен, если ошибка не обнаружена во время прогона.

При системном тестировании мы рассматриваем систему как черный ящик. Тестовый случай (test case) представляет собой пару (входные данные, ожидаемый результат), в которой входные данные – это описание данных, подаваемых на вход нашей системы, а ожидаемый результат - это описание выходных данных, которые система должна предъявить в ответ на соответствующий ввод. Выполнение (прогон) тестового случая – это сеанс работы системы, в рамках которого на вход системы подаются наборы данных, предусмотренные спецификацией тестового случая, и фиксируются результаты их обработки, которые затем сравниваются с ожидаемыми результатами, указанными в тестовом случае. Если фактический результат отличается от ожидаемого, значит, обнаружен отказ, т.е. тестируемая система не прошла испытание на заданном тестовом случае. Если полученный результат совпадает с ожидаемым, значит, тестируемая система прошла испытание на заданном тестовом случае. Из тестовых случаев формируются тестовые наборы (test suits). Тестовые наборы организованы в определенном порядке, отражающем свойства тестовых случаев. Если система успешно справилась со всеми тестовыми случаями из набора, то она успешно прошла испытания на тестовом наборе.

Для нашей системы входными данными является состояние окружения ее компонентов:

Склад. Состояние склада будет характеризоваться следующими параметрами:

Статус склада (StoreStat)

Сообщение от склада о результатах выполнения команды (StoreMessage)

Сообщение от склада о результатах получения команды - статус команды (CommandStatus).

Терминал подшипника. Состояние терминала подшипника задается следующими параметрами:

Статус обмена с терминалом подшипника

Характеристики (параметры) подшипника (RollerPar):

ФИО мастера, производившего измерения

Название депо

Номер рабочей смены

Номер подшипника

Номер группы подшипника

Тип сепаратора подшипника

Терминал оси. Состояние терминала оси задается следующими параметрами:

Статус обмена с терминалом оси

Характеристики (параметры) оси (AxlePar):

ФИО мастера, производившего измерения

Название депо

Номер оси

Сторона оси: правая или левая

Посадочный диаметр задний

Посадочный диаметр передний.

База данных (БД). В БД хранятся характеристики поступивших на склад подшипников. При выборе подходящего для оси подшипника система обращается за этой информацией к БД. Поэтому имеет смысл предварительно очистить БД или заполнить ее определенными данными.

В спецификации тестового случая должны быть заданы состояние окружения (входные данные) и ожидаемая последовательность событий в системе (ожидаемый результат). После прогона тестового случая мы получим реальную последовательность событий в системе (выходные данные) при заданном состоянии окружения. Сравнивая фактический результат и ожидаемый, можно сделать вывод о том, прошла ли тестируемая система испытание на заданном тестовом случае. В качестве ожидаемого результата будем использовать пошаговое описание случая использования (use-case), так как оно определяет, как при заданном состоянии окружения система должна функционировать. Задавая ожидаемый результат, очень важно помнить о том, что при заданном состоянии окружения возможны различные варианты последовательности событий системы, которые все являются правильными.

В процессе работы последовательность событий (команд) системы, или история системы, записывается в журнал (log) системы. Вы можете использовать SystemLogAnimator (см. п.14 SysLog Animator Manual) для визуализации журнала системы. Выбирая различные log-файлы системы для визуализации, можно получить наглядное и достаточно полное представление о функционировании системы и о том, какие события и в каком порядке могут происходить в системе.

3 Планирование тестирования

3.1 Процесс тестирования

Процесс тестирования находится в прямой зависимости от процесса разработки программного обеспечения, но при этом сильно отличается от него, поскольку преследует другие цели. Разработка ориентирована на построение программного продукта, тогда как тестирование отвечает на вопрос, соответствует ли разрабатываемый программный продукт требованиям, в которых зафиксирован первоначальный замысел изделия (т.е. то, что заказал заказчик).

Вместе оба процесса охватывают виды деятельности, необходимые для получения качественного продукта. Ошибки могут быть привнесены на каждой стадии разработки. Следовательно, каждому этапу разработки должен соответствовать этап тестирования. Отношения между этими процессами таковы, что если что-то разрабатывается, то оно подвергается тестированию, а результаты тестирования используются для определения, соответствует ли это «что-то» набору предъявляемых требований. Процесс тестирования возвращает выявленные им ошибки в процесс разработки. Процесс разработки передает процессу тестирования новые и исправленные проектные версии.

3.2 Планирование тестирования

Как было отмечено выше, процесс тестирования тесно связан с процессом разработки. Соответственно планирование тестирования тоже зависит от выбранной модели разработки. Однако вне зависимости от модели разработки при планировании тестирования необходимо ответить на пять вопросов, определяющих этот процесс:

Кто будет тестировать и на каких этапах?

Разработчики продукта, независимая группа тестировщиков или совместно?

Какие компоненты надо тестировать?

Будут ли подвергнуты тестированию все компоненты программного продукта или только компоненты, которые угрожают наибольшими потерями для всего проекта?

Когда надо тестировать?

Будет ли это непрерывный процесс, вид деятельности, выполняемый в специальных контрольных точках, или вид деятельности, выполняемый на завершающей  стадии разработки?

Как надо тестировать?

Будет ли тестирование сосредоточено только на проверке того, что данный продукт должен выполнять, или также на том, как это реализовано?

В каком объеме тестировать?

Как определить, в достаточном ли объеме выполнено тестирование, или как распределить ограниченные ресурсы, выделенные под тестирование?

3.2.1 Кто будет тестировать

Разработчик – это роль, для которой характерны виды деятельности, ориентированные на создание программного продукта (ПП).

Тестировщик – это роль, для которой характерны виды деятельности, ориентированные на обнаружение ошибок в ПП. Эта роль предусматривает выбор тестов, необходимых для конкретных целей, построение тестов, выполнение тестов и оценку результатов. Конкретный исполнитель проекта может выступать как в роли разработчика, так и в роли тестировщика. Момент начала тестирования в проекте можно регулировать (Рис. 3‑1).
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Рис. 3‑1 Кто тестирует

В рамках данного практикума студенту предназначена роль тестировщика.

3.2.2 Какие компоненты надо тестировать

Могут быть варианты, когда ничего не надо тестировать (поскольку все компоненты были протестированы ранее), а может потребоваться тестировать каждый компонент с точностью до строки кода. В объектно-ориентированном программировании базовым компонентом является класс. В этом случае область тестирования определяется классами. Область тестирования на уровне классов подлежит выбору (Рис. 3‑2). Классы, заимствованные из других проектов или взятые из библиотек, чаще всего в повторном тестировании не нуждаются. Существуют различные стратегии по выбору подмножества классов для тестирования.
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Рис. 3‑2 Что тестировать

В нашем случае будет производиться тестирование всех классов приложения.

3.2.3 Когда надо тестировать

Компоненты можно тестировать на завершающем этапе, когда они будут интегрированы в единый выполняемый модуль. Частота тестирования определяется различными соображениями. Можно проводить тестирование каждый день, учитывая тот факт, что чем раньше выявлена проблема, тем легче и дешевле ее решение. Можно  тестировать программный компонент по мере завершения его разработки (Рис. 3‑3). Частое тестирование компонентов несколько замедляет ранние этапы разработки, однако сопряженные с этим потери с лихвой восполняются за счет меньшего числа проблем на более поздних этапах разработки проекта, когда отдельные модули объединяются в более крупные компоненты системы.

В случае, когда компоненты системы не отличаются большой сложностью, можно сначала осуществлять интегрирование не подвергавшихся автономному тестированию компонентов, а затем тестировать объединенный код как единое целое. Такой подход полезен при тестировании компонентов, для которых реализация тестовых драйверов требует существенных усилий. Тестовый драйвер представляет собой программу, которая выполняет прогон тестовых случаев и сбор полученных при этом результатов.
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Рис. 3‑3 Когда тестировать

Студентам предлагается тестировать компоненты по мере их готовности.

3.2.4 Как надо тестировать

Основные подходы к тестированию ПО основаны на спецификации и реализации (Рис. 3‑4)

Спецификация модуля (или класса) ПП определяет, что этот модуль должен делать, т.е. она описывает допустимые наборы входных данных, подаваемых на вход модуля, включая ограничения на то, как многократные вводы данных должны соотноситься друг с другом, и какие выходные данные соответствуют различным наборам входных данных. 

Реализация модуля ПП есть выражение алгоритма, порождающего выходные результаты для различных наборов входных данных с соблюдением требований спецификации. Спецификация указывает, что делает модуль ПП, а реализация показывает, как модуль ПП это делает. Полный учет требований спецификации дает гарантию того, что ПП выполняет все, что от него требуется. Полный учет требований к реализации дает гарантию того, что ПП не будет делать того, что от него не требуется.

Спецификация играет важную роль в тестировании. Обычно для множества компонентов ПП создаются спецификации, обеспечивающие разработку и тестирование, включая спецификации систем, подсистем и классов.

Наряду с автономным тестированием компонентов (классов) системы (модульным уровнем тестирования), необходимо тестировать взаимодействие между различными компонентами (интеграционный уровень тестирования). Цель интеграционного тестирования заключается в обнаружении отказов, возникающих вследствие ошибок в интерфейсах или в силу неверных предположений относительно интерфейсов. После интеграционного тестирования проводится системное тестирование ПП (системный уровень). На этом уровне тестированию подвергается система как единое целое.
Тестирование следует осуществлять в достаточных объемах, чтобы быть более-менее уверенным в том, что ПП функционирует в соответствии с предъявленными к нему требованиями, т.е. выполняется принцип адекватности тестирования ПП. Адекватность можно измерить, используя понятие покрытия. Покрытие можно измерить двумя способами. Первый заключается в подсчете количества требований, сформулированных в спецификации, которые подверглись тестированию. Второй способ заключается в подсчете выполненных компонентов ПП в результате прогона тестового набора. Набор тестов можно считать адекватным, если определенная часть строк исходного кода или исполняемых ветвей исходного кода была выполнена, по крайней мере, один раз во время прогона тестового набора. Эти два способа измерения отражают два базовых подхода к тестированию:

При использовании первого подхода проверяется, что должен выполнять ПП.

При использовании второго подхода проверяется, как фактически работает ПП.

При тестировании в соответствии со спецификацией (функциональном тестировании или тестировании «черного ящика») построение тестовых случаев производится в соответствии со спецификацией и не зависит от того, как реализован ПП. Эффективность зависит от качества спецификации и способности тестировщика корректно ее интерпретировать.

При структурном тестировании (тестировании в соответствии с реализацией или тестировании «белого ящика») построение тестовых случаев производится на основе программного кода, представляющего собой реализацию ПП. Входные данные каждого тестового случая должны быть определены спецификацией ПП, однако они могут быть выбраны на основе анализа самого программного кода для прохождения той или иной ветви программы. При этом покрытие увеличивается.
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Рис. 3‑4 Как тестировать

Мы будем использовать оба подхода. При тестировании классов мы будем стремиться покрыть как спецификации классов, так и код их реализации. При тестировании взаимодействий будем покрывать спецификацию. При системном тестировании также будем стремиться покрыть спецификацию системы.

3.2.5 В каком объеме тестировать

Различные уровни адекватного тестирования изображены на Рис. 3‑5, который охватывает случаи от отсутствия тестирования до исчерпывающего тестирования, когда выполняется прогон всех возможных тестовых случаев. Объем необходимого тестирования следует определять исходя из краткосрочных и долгосрочных целей проекта и в соответствии с особенностями разрабатываемого ПП. Покрытие – это мера полноты использования возможностей программного компонента тестовым набором.

Например, одна из мер - задействована ли каждая строка программного кода продукта хотя бы один раз при прогоне данного тестового набора. Другая мера – количество требований спецификации, проверенных данным тестовым набором. Если требования сформулированы в терминах случаев использования, то покрытие измеряется количеством случаев использования и числом сценариев, построенных для каждого случая использования.

Анализ рисков в процессе тестирования применяется для определения уровня детализации и времени, затрачиваемого на тестирование конкретного компонента. Например, на тестирование классов, более важных для приложения, отводится больше времени.
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Рис. 3‑5 В каком объеме тестировать

Мы будем использовать все перечисленные меры.

Ответы на поставленные вопросы и, возможно, на многие другие, оформляются в виде набора документов, принятого в компании. Например, тестовый план может содержать следующую информацию: 

1. Перечень тестовых ресурсов.

2. Перечень функций и подсистем, подлежащих тестированию.

3. Тестовую стратегию:

Анализ функций и подсистем с целью определения слабых мест, требующих исчерпывающего тестирования, то есть участков функциональности, где появление дефектов наиболее вероятно.

Определение стратегии выбора входных данных для тестирования. Поскольку в реальных применениях множество входных данных программного продукта  практически бесконечно, выбор конечного подмножества для проведения тестирования является сложной задачей. Для ее решения могут быть применены методы покрытия классов входных и выходных данных, анализ крайних значений, покрытие случаев использования и тому подобное. Выбранная стратегия должна быть обоснована и задокументирована.

Определение потребности автоматизации процесса тестирования. При этом решение об использовании существующей, либо о создании новой автоматизированной системы тестирования должно быть обосновано, а оценка затрат на создание новой системы или на внедрение уже существующей должна демонстрировать ??. 
4. График (расписание) тестовых циклов.

5. Указание конкретных параметров аппаратуры и программного окружения.

6. Определение тестовых метрик, которые необходимо собирать и анализировать, таких как покрытие набора требований, покрытие кода, количество и уровень серьезности дефектов, объем тестового кода и т.п.

4 Модульное тестирование НА ПРИМЕРЕ классов

Цель тестирования программных модулей состоит в том, чтобы удостовериться, что каждый модуль соответствует своей спецификации. Если это так, то причиной любых ошибок, которые возникают при их объединении, является неправильная стыковка модулей. В процедурно-ориентированном программировании модулем называется процедура или функция, иногда группа процедур, которая реализует абстрактный тип данных. Тестирование модулей обычно представляет собой некоторое сочетание проверок и прогонов тестовых случаев. Можно составить план тестирования модуля, в котором учесть тестовые случаи и построение тестового драйвера.

Тестирование классов аналогично тестированию модулей. Основным элементом объектно-ориентированной программы является класс. Рассмотрим методику тестирования отдельного класса. Тестирование классов охватывает виды деятельности, ассоциированные с проверкой реализации класса на точное соответствие спецификации класса. Если реализация корректна, то каждый экземпляр этого класса ведет себя подобающим образом.

Эффективного тестирования классов можно достичь при помощи ревью и тестовых прогонов. Ревью представляет собой просмотр исходного кода ПО с целью обнаружения ошибок и дефектов, возможно, до того, как это ПО заработает. Ревьюирование предназначено для выявления таких ошибок, как неспособность выполнять то или иное требование спецификации или ее неправильное понимание, а также алгоритмических ошибок в реализации. Тестовый прогон обеспечивает тестирование ПО в процессе выполнения программы. Осуществляя прогон программы, тестировщик стремится определить, способна ли программа вести себя в соответствии со спецификацией. Тестировщик должен выбрать наборы входных данных, определить соответствующие им правильные наборы выходных данных и сопоставить их с реально получаемыми выходными данными.

Рассмотрим тестирование классов в режиме прогона тестовых случаев. После идентификации тестовых случаев для класса нужно реализовать тестовый драйвер, обеспечивающий прогон каждого тестового случая, и запротоколировать результаты каждого прогона. При тестировании классов тестовый драйвер создает один или большее число экземпляров тестируемого класса и осуществляет прогон тестовых случаев. Тестовый драйвер может быть реализован как автономный тестирующий класс.

4.1 Кто, что, когда, как и в каком объеме

Рассмотрим эти вопросы в контексте тестирования классов:

Кто выполняет тестирование? Обычно тестирование классов выполняют их разработчики. В этом случае время на изучение спецификации и реализации сводится к минимуму. Недостатком подхода является то, что если разработчик неправильно понял спецификации, то он для своей неправильной реализации разработает и “ошибочные” тестовые наборы.

Что тестировать? Необходимо удостовериться, что программный код класса в точности отвечает требованиям, сформулированным в его спецификации, и что он не делает ничего более.

В какой момент следует выполнять тестирование? План тестирования или хотя бы тестовые случаи должны разрабатываться после составления полной спецификации класса. Разработка тестовых случаев по мере реализации класса помогает разработчику лучше понять спецификацию. Тестирование класса должно проводиться до того, как возникнет необходимость использовать этот класс в других компонентах ПО. Регрессионное тестирование класса должно выполняться всякий раз, когда меняется реализация класса. Регрессионное тестирование позволяет убедиться в том, что разработанные и оттестированные функции продолжают удовлетворять спецификации после выполнения модификации ПО.

Как будет выполняться тестирование? Тестирование классов обычно выполняется путем разработки тестового драйвера, который создает экземпляры классов и окружает эти экземпляры соответствующей средой (тестовым окружением), чтобы стал возможен прогон соответствующего тестового случая. Драйвер посылает сообщения экземпляру класса в соответствии со спецификацией тестового случая, а затем проверяет исход этих сообщений. Тестовый драйвер должен удалять созданные им экземпляры тестируемого класса. Статические элементы данных класса также необходимо тестировать.

Какие объемы тестирования следует считать адекватными? Адекватность может быть измерена полнотой охвата тестами спецификации или реализации. Будем использовать оба способа.  

4.1.1 Что тестировать

Можно выделить два типа классов с точки зрения их взаимодействия с другими классами:

Примитивные классы

Непримитивные классы.

Примитивный класс может порождать экземпляры, и эти экземпляры можно использовать без необходимости создания экземпляров каких-либо других классов, в том числе и данного класса. Такие объекты представляют собой простейшие компоненты системы и, несомненно, играют важную роль при выполнении любой программы. Тем не менее, в объектно-ориентированной программе существует сравнительно небольшое количество примитивных классов, которые реалистично моделируют объекты задачи и все отношения между этими объектами. Обычным явлением для хорошо спроектированных объектно-ориентированных программ является использование непримитивных классов. Основываясь на этой информации, определим, к какому типу относится каждый класс в нашем приложении (Табл. 4‑1).

Табл. 4‑1 Типы Классов 

	Класс
	Тип

	TBearingParam
	Примитивный

	TAxleParam
	Примитивный

	TCommand
	Примитивный

	TLog
	Примитивный

	TCommandQueue
	Непримитивный

	TStore
	Непримитивный

	TTerminalBearing
	Непримитивный

	TTerminalAxle
	Непримитивный

	TModel
	Непримитивный

	MainForm
	Непримитивный


В большинстве объектно-ориентированных языков члены класса имеют один из трех уровней доступа:

Public. Члены с доступом public доступны из любых классов. Они образуют интерфейс класса, которым будет пользоваться любой разработчик, использующий данный класс в своем приложении.

Private. Члены с доступом private доступны только внутри самого класса, то есть из его методов. Они являются частью внутренней реализации класса и недоступны стороннему разработчику.

Protected. Члены с доступом protected доступны из самого класса и из классов, являющихся его потомками, но недоступны извне. Использование этих методов возможно только при создании класса-потомка, расширяющего функциональность базового класса.

Таким образом, необходимость тестирования функциональности класса зависит от того, предоставляется ли им возможность наследования. Если класс является законченным (final) и не предполагает наследования, необходимо тестирование его public части (впрочем, классы final не содержат protected членов). Если же класс рассчитан на расширение за счет наследования, необходимо тестирование также его protected части.

Кроме того, во многих языках класс может содержать статические (static) члены, которые принадлежат классу в целом, а не его конкретным экземплярам. При наличии public static или protected static членов, кроме тестирования объектов класса, должно отдельно выполняться тестирование статической части класса.

4.1.2 Как тестировать

Как уже упоминалось, для тестирования классов применяются тестовые драйверы. Существует несколько способов реализации тестового драйвера:

Тестовый драйвер реализуется в виде отдельного класса. Методы этого класса создают объекты тестируемого класса и вызывают их методы, в том числе статические методы класса. Таким способом можно тестировать public часть класса.

Тестовый драйвер реализуется в виде класса, наследуемого от тестируемого. В отличие от предыдущего способа, такому тестовому драйверу доступна не только public, но и protected часть.

Тестовый драйвер реализуется непосредственно внутри тестируемого класса (в класс добавляются диагностические методы). Такой тестовый драйвер имеет доступ ко всей реализации класса, включая private члены. В этом случае в методы класса включаются вызовы отладочных функций и агенты, отслеживающие некоторые события при тестировании.

В дальнейшем мы будем использовать первый способ при реализации драйверов.

При разработке спецификации класса можно задействовать один из следующих подходов:

Контрактный подход. Интерфейс определяется в виде обязательств отправителя и получателя, вступивших во взаимодействие. Операция определяется как набор обязательств каждой стороны, причем ответственность по отношению друг к другу соблюдается как отправителем, так и получателем.

Подход защитного программирования. Интерфейс определяется главным образом в терминах получателя. Операция возвращает результат запроса – успешное или неудачное выполнение по конкретной причине (например, по недопустимому входному значению). Другими словами, соответствующий получатель следит за тем, чтобы на вход не попали некорректные данные, т.е. проверяет правильность и допустимость входных данных, и после получения запроса сообщает отправителю результат обработки запроса.

Различие между контрактным и защитным методами проектирования распространяется и на тестирование. Контрактное проектирование возлагает большую ответственность на проектировщика, чем на программы поиска ошибок. Основное внимание во время тестирования взаимодействий в условиях контактного подхода уделяется проверке, выполнены ли объектом-отправителем предусловия методов получающего объекта. Не допускается построение тестовых случаев, нарушающих эти предусловия. Обычно практикуется перевод объекта-получателя в некоторое заданное состояние, после чего инициируется выполнение тестового драйвера, по условиям которого объект-отправитель требует, чтобы объект-получатель находился в другом состоянии. Смысл подобной проверки заключается в том, чтобы установить, выполняет ли объект-отправитель проверку предусловий объекта-получателя, прежде чем отправить заранее неприемлемое сообщение и корректно ли он прекращает свою работу.

4.2 Подробное описание тестового случая

Рассматривается пример тестов на C# для класса Tcommand (Приложение 2 (HLD)). При выполнении заданий необходимо будет самостоятельно написать тесты для других классов приложения. Параллельно с изучением этого раздела полезно открыть проект ModuleTesting\ModuleTests.sln.

Рассмотрим тестирование класса TCommand. Этот класс реализует единственную операцию GetFullName(), которая возвращает полное название команды в виде строки. Разработаем спецификацию тестового случая для тестирования метода GetFullName на основе спецификации этого класса (Приложение 2):

	Название класса: TСommand 
	Название тестового случая: TСommandTest1

	Описание тестового случая: Тест проверяет правильность работы метода GetFullName – получения полного названия команды на основе кода команды. В тесте подаются следующие значения кодов команд (входные значения): -1, 1, 2, 4, 6, 20, где -1 – запрещенное значение

	Начальные условия: Нет

	Ожидаемый результат:

Перечисленным входным значениям должны соответствовать следующие выходные:

Коду команды -1 должно соответствовать сообщение  «ОШИБКА: Неверный код команды»

Коду команды 1 должно соответствовать полное название команды «ПОЛУЧИТЬ ИЗ ВХОДНОЙ ЯЧЕЙКИ»

Коду команды 2 должно соответствовать полное название команды «ОТПРАВИТЬ ИЗ ЯЧЕЙКИ В ВЫХОДНУЮ ЯЧЕЙКУ»

Коду команды 4 должно соответствовать полное название команды «ПОЛОЖИТЬ В РЕЗЕРВ»

Коду команды 6 должно соответствовать полное название команды «ПРОИЗВЕСТИ ЗАНУЛЕНИЕ»

Коду команды 20 должно соответствовать полное название команды «ЗАВЕРШЕНИЕ КОМАНД ВЫДАЧИ»


На основе спецификации был создан тестовый драйвер - класс TCommandTester, наследующий функциональность абстрактного класса Tester.


public class Log

{


static private StreamWriter log=new StreamWriter("log.log"); //Создание лог файла

static public void Add(string msg) //Добавление сообщения в лог файл

{



log.WriteLine(msg);


}


static public void Close() //Закрыть лог файл

{



log.Close();


}

}

abstract class Tester

{

protected void LogMessage(string s) 

//Добавление сообщения в лог-файл


{



Log.Add(s);


}

}

class TCommandTester:Tester // Тестовый драйвер
{


TCommand OUT; 


public TCommandTester()


{



OUT=new TCommand();



Run();


}


private void Run()


{



TCommandTest1();


}


private void TCommandTest1()


{



int[] commands = {-1, 1, 2, 4, 6, 20};



for(int i=0;i<=5;i++)



{




OUT.NameCommand=commands[i];




LogMessage(commands[i].ToString()+" : "+OUT.GetFullName());



}


}


[STAThread]


static void Main() 


{



TCommandTester CommandTester = new TCommandTester();



Log.Close();


}

}

Рис. 4‑1. Тестовый драйвер 

Класс TCommandTester содержит метод TCommandTest1(), в котором реализована вся функциональность теста. В данном случае для покрытия спецификации достаточно перебрать следующие значения кодов команд: -1, 1, 2, 4, 6, 20, где -1 – запрещенное значение, и получить соответствующие им полное название команды с помощью метода GetFullName(). Пары соответствующих значений заносятся в log-файл для последующей проверки на соответствие спецификации. 

Таким образом, для тестирования любого метода класса необходимо:

Определить, какая часть функциональности метода должна быть протестирована, то есть при каких условиях он должен вызываться. Под условиями здесь понимаются параметры вызова методов, значения полей и свойств объектов, наличие и содержимое используемых файлов и т. д.

Создать тестовое окружение, обеспечивающее требуемые условия.

Запустить тестовое окружение на выполнение.

Обеспечить сохранение результатов в файл для их последующей проверки.

После завершения выполнения сравнить полученные результаты со спецификацией.

4.3 Описание тестовых процедур

4.3.1 Как запустить тест

Для того чтобы запустить тест, нужно:

В методе Run тестового драйвера TCommandTester вызвать метод TCommandTest1, реализующий тест.

Собрать и запустить приложение.

4.3.2 Проверка результатов выполнения тестов (сравнение с ожидаемым результатом)

После завершения теста следует просмотреть текстовый журнал теста (..\ModuleTesting\bin\Debug\log.log), чтобы сравнить полученные результаты с ожидаемыми результатами, заданными в спецификации тестового случая TСommandTest1. Журнал теста:

-1 : ОШИБКА : Неверный код команды

1 : ПОЛУЧИТЬ ИЗ ВХОДНОЙ ЯЧЕЙКИ

2 : ОТПРАВИТЬ ИЗ ЯЧЕЙКИ В ВЫХОДНУЮ ЯЧЕЙКУ

4 : ПОЛОЖИТЬ В РЕЗЕРВ

6 : ПРОИЗВЕСТИ ЗАНУЛЕНИЕ

20 : ЗАВЕРШЕНИЕ КОМАНД ВЫДАЧИ

4.4 Задание 1

Для остальных примитивных классов (Табл. 4‑1) в соответствии с приведенным примером необходимо самостоятельно разработать спецификации тестовых случаев, соответствующие тесты и провести тестирование. Отчет требуется составить в следующей форме (Рис. 4‑2):

	Название тестового случая:

	Тестировщик:

	Тест пройден: Да/Нет (PASS/FAIL)

	Степень важности ошибки:

                             Фатальная (3 уровень – crash)

                             Серьезная (2 уровень – расхождение в спецификации)

                             Незначительная (1 уровень – незначительная ошибка)

	Описание проблемы:

	Как воспроизвести ошибку:

	Предлагаемое исправление (необязательно):

	Комментарий тестировщика (необязательно):


Рис. 4‑2 Тестовый отчет

5 Интеграционное тестирование

Основное назначение тестирования взаимодействий состоит в том, чтобы убедиться, что происходит правильный обмен сообщениями между объектами, классы которых уже прошли тестирование в автономном режиме (на модульном уровне тестирования).

Тестирование взаимодействия или интеграционное тестирование представляет собой тестирование собранных вместе, взаимодействующих модулей (объектов). В интеграционном тестировании можно объединять разное количество объектов – от двух до всех объектов тестируемой системы. Интеграционное тестирование отличается от системного тем, что:

· При интеграционном тестировании используется подход «белого ящика», а при системном - «черного ящика».

· Целью интеграционного тестирования является только проверка правильности взаимодействия объектов, тогда как целью системного – проверка правильности функционирования системы в целом. 

5.1 Идентификация взаимодействий

Взаимодействие объектов представляет собой просто запрос одного объекта (отправителя) на выполнение другим объектом (получателем) одной из операций получателя и всех видов обработки, необходимых для завершения этого запроса.

В ситуациях, когда в качестве основы тестирования взаимодействий объектов выбраны только спецификации общедоступных операций, тестирование намного проще, чем когда такой основой служит реализация. Мы ограничимся тестированием общедоступного интерфейса. Такой подход вполне оправдан, поскольку мы полагаем, что классы уже успешно прошли модульное тестирование. Тем не менее, выбор такого подхода отнюдь не означает, что не нужно возвращаться к спецификациям классов, дабы убедиться в том, что тот или иной метод выполнил все необходимые вычисления. Это обусловливает необходимость проверки значений атрибутов внутреннего состояния получателя, в том числе любых агрегированных атрибутов, т.е. атрибутов, которые сами являются объектами. Основное внимание уделяется отбору тестов на основе спецификации каждой операции из общедоступного интерфейса класса.

Взаимодействия неявно предполагаются в спецификации класса, в которой установлены ссылки на другие объекты. В разделе 4 рассматривалось тестирование примитивных классов. Такие объекты представляют собой простейшие компоненты системы и, несомненно, играют важную роль при выполнении любой программы. Тем не менее, в объектно-ориентированной программе существует сравнительно небольшое количество примитивных классов, которые реалистично моделируют объекты задачи и все отношения между этими объектами. Обычным явлением для хорошо спроектированных объектно-ориентированных программ является использование непримитивных классов; в этих программах им отводится главенствующая роль.

Выявить такие взаимодействующие классы можно, используя отношения ассоциации (в том числе отношения агрегирования и композиции), представленные на диаграмме классов. Ассоциации такого рода преобразуются в интерфейсы класса, а тот или иной класс взаимодействует с другими классами посредством одного или нескольких способов:

Тип 1. Общедоступная операция имеет один или большее число формальных параметров объектного типа. Сообщение устанавливает ассоциацию между получателем и параметром, которая позволяет получателю взаимодействовать с этим параметрическим объектом.

Тип 2. Общедоступная операция возвращает значения объектного типа. На класс может быть возложена задача создания возвращаемого объекта, либо он может возвращать модифицированный параметр.

Тип 3. Метод одного класса создает экземпляр другого класса как часть своей реализации. 

Тип 4. Метод одного класса ссылается на глобальный экземпляр некоторого другого класса. Разумеется, принципы хорошего тона в проектировании рекомендуют минимальное использование глобальных объектов. Если реализация какого-либо класса ссылается на некоторый глобальный объект, рассматривайте его как неявный параметр в методах, которые на него ссылаются.

Приведем еще раз таблицу разделения классов на примитивные и непримитивные типы (Табл. 5‑1):

Табл. 5‑1Типы классов

	Класс
	Тип

	TBearingParam
	Примитивный

	TAxleParam
	Примитивный

	TCommand
	Примитивный

	TLog
	Примитивный

	TCommandQueue
	Непримитивный

	TStore
	Непримитивный

	TTerminalBearing
	Непримитивный

	TTerminalAxle
	Непримитивный

	TModel
	Непримитивный

	MainForm
	Непримитивный


Для непримитивных классов определим типы взаимодействия (Табл. 5‑2). Числа в ячейках этой таблицы обозначают тип взаимодействия.

Табл. 5‑2. Типы взаимодействия классов

	Непримитивные типы
	Tbearing

Param
	Taxle

Param
	Tcom-mand
	TCommand

Queue
	TStore
	TTerminalBearing
	TTerminalAxle
	TLog
	Tmo-del

	TCommandQueue
	1
	1
	3
	 
	1
	1
	 
	 
	 

	TStore
	3
	1
	1
	 
	 
	 
	 
	 
	 

	TTerminalBearing
	3
	 
	 
	 
	 
	 
	 
	 
	 

	TTerminalAxle
	 
	3
	 
	 
	 
	 
	 
	 
	 

	TModel
	 
	 
	 
	3
	3
	3
	3
	3
	 

	MainForm
	 
	 
	 
	 
	 
	 
	 
	 
	3


Таким образом, интеграционному тестированию будут подвергнуты взаимодействия перечисленных непримитивных классов.

5.2 Выбор тестовых случаев

Исчерпывающее тестирование, другими словами, прогон каждого возможного тестового случая, покрывающего каждое сочетание значений – вне всяких сомнений, это надежный подход к тестированию. Однако во многих ситуациях количество тестовых случаев достигает таких больших значений, что обычными методами с ними справиться попросту невозможно. Если  имеется принципиальная возможность построения такого большого количества тестовых случаев, на построение и выполнение которых не хватит никакого времени, должен быть разработан систематический метод определения, какими из тестовых случаев следует воспользоваться. Если есть выбор, то мы отдаем предпочтение таким тестовым случаям, которые позволяют найти ошибки, в обнаружении которых мы заинтересованы больше всего.

Существуют различные способы определения, какое подмножество из множества всех возможных тестовых случаев следует выбирать. При любом подходе мы заинтересованы в том, чтобы систематически повышать уровень покрытия.

5.3 Подробное описание тестового случая

Продемонстрируем тестирование взаимодействий на примере класса TCommandQueue. Из Табл. 5‑2, которая была составлена на основе спецификаций классов, описанных в Приложении 2, видно, что класс очереди команд взаимодействует со следующими классами:

TBearingParam

TAxleParam

TCommand

TStore

TterminalBearing.

С объектом TCommand осуществляется взаимодействие третьего типа, т.е. TCommandQueue создает объекты класса TCommand как часть своей внутренней реализации. С остальными классами осуществляется взаимодействие первого типа: ссылки на объекты классов TStore и TTerminalBearing передаются как параметры в конструктор TCommandQueue, а ссылки на объекты классов TBearingParam и TAxleParam передаются в метод TCommandQueue.AddCommand.

Одновременно с изучением этого раздела можно открыть проект IntegrationTesting\IntegrationTests.sln.

Для тестирования взаимодействия класса TCommandQueue и класса TСommand, так же, как и при модульном теcтировании, разработаем спецификацию тестового случая:

Табл. 5‑3. Спецификация тестового случая

	Названия взаимодействующих классов:

TСommandQueue, TCommand 
	Название теста: TCommandQueueTest1

	Описание теста: Тест проверяет возможность создания объекта типа TCommand и добавления его в очередь при вызове метода AddCommand

	Начальные условия: Очередь команд пуста

	Ожидаемый результат: В очередь будет добавлена одна команда


На основе этой спецификации был разработан тестовый драйвер - класс TCommandQueueTester, который наследуется от класса Tester. Этот класс содержит:

Метод Init, в котором создаются объекты классов TStore, TterminalBearing и объект типа TcommandQueue. Этот метод необходимо вызывать в начале каждого теста, чтобы тестируемые объекты создавались вновь:


private void Init()

{


TB = new TTerminalBearing();


S = new TStore();


CommandQueue=new TCommandQueue(S,TB);


S.CommandQueue=CommandQueue;

}

Рис. 5‑1. Метод Init
Методы, реализующие тесты. Каждый тест реализован в отдельном методе.

Метод Run, в котором вызываются методы тестов.

Метод dump, который сохраняет в log-файле теста информацию обо всех командах, находящихся в очереди в формате – Номер позиции в очереди: полное название команды.

Точку входа в программу – метод Main, в котором происходит создание экземпляра класса TCommandQueueTester и запуск метода Run.

Сначала создадим тест, который проверяет, создается ли объект типа TСommand, и добавляется ли команда в конец очереди.

private void TCommandQueueTest1()

{

Init();

LogMessage("///////// TCommandQueue Test1  /////////////");

LogMessage("Проверяем, создается ли объект типа TCommand");

// В очереди нет команд

dump();

// Добавляем команду 

// параметр = -1 означает, что команда должна быть добавлена //в конец очереди

CommandQueue.AddCommand(TCommand.GetR,0,0,0,new TBearingParam(),new TAxleParam(),-1);

LogMessage("Command added");

// В очереди одна команда

dump();

}

Рис. 5‑2 Тест, проверяющий создание объекта типа TСommand

В этот класс включены еще два разработанных теста.

5.4 Описание тестовых процедур

5.4.1 Как запустить тест

Для выполнения этого теста в методе Run необходимо вызвать метод TCommandQuеueTest1() и запустить программу на выполнение:


private void Run()

{


TCommandQueueTest1();

}

Рис. 5‑3. Метод Run 

5.4.2 Проверка результатов выполнения тестов (сравнение с ожидаемым результатом)

После завершения теста следует просмотреть текстовый журнал теста (..\IntegrationTesting\bin\Debug\test.log), чтобы сравнить полученные результаты с ожидаемыми результатами, заданными в спецификации тестового случая TCommandQueueTest1.

	////////////////////    TCommandQueue Test1  //////////////////

Проверяем, создается ли объект типа TCommand

0 commands in command queue

Command added

1 commands in command queue

0 :   ПОЛУЧИТЬ ИЗ ВХОДНОЙ ЯЧЕЙКИ


Рис. 5‑4 Журнал теста

5.5 Задание 2

Для тестирования взаимодействия остальных непримитивных классов (Табл. 4‑1) по аналогии с приведенным примером требуется самостоятельно разработать спецификации тестовых случаев, соответствующие тесты, провести тестирование и составить тестовые отчеты 
(Рис. 4‑2).

6 Системное тестирование

Системное тестирование качественно отличается от интеграционного и модульного уровней. Системное тестирование рассматривает систему в целом и применяется на уровне пользовательских интерфейсов, в отличие от последних фаз интеграционного тестирования, которое оперирует на уровне интерфейсов модулей, хотя набор модулей может быть аналогичным. Различны и цели этих уровней тестирования. На уровне системы часто сложно и малоэффективно анализировать прохождение тестовых траекторий внутри программы, а также отслеживать правильность работы конкретных функций. Основной задачей системного тестирования является выявление дефектов, связанных с работой системы в целом, таких как неверное использование ресурсов системы, непредусмотренные комбинации данных пользовательского уровня, несовместимость с окружением, непредусмотренные сценарии использования, отсутствующая или неверная функциональность, неудобство в использовании и тому подобное.

Поскольку системное тестирование проводится на уровне пользовательских интерфейсов, то построение специальной тестовой системы становится технически необязательным. Однако объемы данных на этом уровне таковы, что обычно более эффективным подходом является полная или частичная автоматизация тестирования, что может потребовать создания тестовой системы намного более сложной, чем система тестирования на уровне модулей или их комбинаций.

Необходимо подчеркнуть, что существует два принципиально разных подхода к системному тестированию.
В первом варианте для построения тестов используются требования к системе, например, для каждого требования строится тест, который проверяет выполнение данного требования в системе. Этот подход особенно широко применяется при разработке военных и научных систем, когда заказчик вполне осознает, какая функциональность ему нужна и составляет полный набор формальных требований. Тестировщик в данном случае только проверяет,   соответствует ли разработанная система этому набору. Такой подход предполагает длинную и дорогостоящую фазу сбора требований, выполняемую до начала собственно проекта. В этом случае для определения требований обычно разрабатывается прототип будущей системы.

Во втором подходе основой для построения тестов служит представление о способах использования продукта и о задачах, которые он решает. На основе более или менее формальной модели пользователя создаются случаи использования системы, по которым затем строятся собственно тестовые случаи. Случай использования (use case) описывает, как субъект использует систему, чтобы выполнить ту или иную задачу. Субъекты или актеры (actors) могут исполнять различные роли при работе с системой. Случаи использования могут описываться с различной степенью абстракции. Случаи использования не обязательно охватывают каждое требование. Можно конкретизировать случаи использования и расширять их в наборы более специфических случаев использования (пошаговое описание случая использования). В контексте конкретного случая использования можно определить один или большее число сценариев. Сценарий представляет конкретный экземпляр случая использования – путь в пошаговом описании случая использования. Каждый путь (сценарий) в случае использования должен быть протестирован (Рис. 6‑1).
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Рис. 6‑1 Тестирование случаев использования

Входные данные для каждого сценария надо выбирать следующим образом:

Идентифицировать все значения (входные данные), которые могут задавать субъекты для случая использования

Определить классы эквивалентности для каждого типа входных данных

Построить таблицу со списком значений из различных классов эквивалентности

Построить тестовые случаи на базе таблицы с учетом внешних ограничений.

Далее при построении тестовых случаев применялись оба подхода и при выполнении заданий необходимо действовать следующим образом:

На основе требований определить случаи использования (use-case)

На основе каждого случая использования (use-case) построить сценарии

Для каждого сценария разработать тестовые случаи (набор тестов).

6.1 Случаи использования (use-cases)

6.1.1 Описание случая использования (use-case) “подбор подшипников для оси”

Последовательно приходят два подшипника, поступает запрос от оси. При поступлении запроса от оси система подбирает два подшипника из имеющихся на складе и выдает их в выходную ячейку.

Рассмотрим этот случай использования подробнее. Согласно спецификации, система постоянно опрашивает склад и терминал оси. При поступлении подшипника (статус склада 32) система опрашивает терминал подшипника, формирует и посылает команду складу “принять подшипник” и получает ответ от склада о результатах выполнения команды. При поступлении оси (поступлении параметров оси при опросе терминала оси) система должна подобрать подшипники из имеющихся на складе, сформировать команды для их выдачи, послать их складу и получить ответ о результате  выполнения команд.

Далее приводится пошаговое описание этого случая использования:

Приняли на склад первый подшипник (1-10)

Приняли на склад второй подшипник (11-20)

Поступила ось (21-26)

Подбираем первый подшипник для оси (27-30)

Подбираем второй подшипник для оси (31-34)

Завершение выдачи команд (35-39).

6.1.2 Пошаговое описание случая использования

Пошаговое описание приведено на Рис. 6‑2
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Рис. 6‑2. Пример Use-case 

6.1.3 Список альтернативных путей

В пошаговом описании случая использования рассматривался оптимистический сценарий, например при анализе статуса склада в пунктах 3 и 11 считалось, что поступил подшипник. Но необходимо рассмотреть и возможные альтернативные сценарии:

3, 11 - анализ статуса склада:

3.a, 11.a- подшипник в манипуляторе

3.b, 11.b - склад свободен

3.c, 11.c - ошибочное состояние.

При получении сообщения от склада о выполнении команды считалось, что команда выполнена без ошибки, но здесь тоже существуют альтернативные варианты:

8, 16, 22, 24,26 – получение сообщения о выполнении команды:

8.a, 16.a, 22.a, 24.a, 26.a – нет склада
8.b, 16.b, 22.b, 24.b, 26.b – нет сообщения

8.с, 16.c, 22.c, 24.c, 26.c – команда выполнена с ошибкой.

Список альтернативных вариантов для рассмотренного случая использования можно продолжить.

6.2 Спецификация тестового случая №1

Состояние окружения (входные данные):

Статус склада (StoreStat=32). Пришел подшипник.

Статус обмена с терминалом подшипника (0 - есть подшипник) и его параметры (RollerPar="0 NewUser Depot1 123456 1 12 1 1")

Статус обмена с терминалом оси (1 - нет оси) и ее параметры (AxlePar="1 NewUser Depot1 123456 1 0 12 12")

Статус команды (CommandStatus=0). Команда успешно принята.

Сообщение от склада (StoreMessage=1). Команда успешно выполнена.

Ожидаемая последовательность событий (выходные данные):

Система запрашивает статус склада (вызов функции GetStoreStat) и получает 32

Система запрашивает параметры подшипника (вызов функции GetRollerPar) и получает 0 NewUser Depot1 123456 1 12 1 1

Система запрашивает параметры оси (вызов функции GetAxlePar) и получает 1 NewUser Depot1 123456 1 0 12 12

Система добавляет в очередь команд склада на последнее место команду SendR (получить из приемника в ячейку) (вызов функции SendStoreCom) и получает сообщение о том, что команда успешно принята - 0

Система запрашивает склад о результатах выполнения команды (вызов функции GetStoreMessage) и получает сообщение о том, что команда успешно выполнена - 1

Система запрашивает статус склада (вызов функции GetStoreStat) и получает 32

Система запрашивает параметры подшипника (вызов функции GetRollerPar) и получает  0 NewUser Depot1 123456 1 12 1 1

Система запрашивает параметры оси (вызов функции GetAxlePar) и получает 1 NewUser Depot1 123456 1 0 12 12

Система добавляет в очередь команд склада на первое место команду GetR (получить из приемника в ячейку) (вызов функции SendStoreCom) и получает сообщение о том, что команда успешно принята - 0

Система запрашивает склад о результатах выполнения команды (вызов функции GetStoreMessage) и получает сообщение о том, что команда успешно выполнена – 1

Изменяем состояние окружения (входные данные):

Статус обмена с терминалом подшипника (1 - нет подшипника) и его параметры (RollerPar="1 NewUser Depot1 123456 1 12 1 1")

Статус обмена с терминалом оси (0 - есть ось) и ее параметры (AxlePar="0 NewUser Depot1 123456 1 0 12 12")

Ожидаемая последовательность событий (выходные данные):

Система запрашивает статус склада (вызов функции GetStoreStat) и получает 32

Система запрашивает параметры подшипника (вызов функции GetRollerPar) и получает 1 NewUser Depot1 123456 1 12 1 1

Система запрашивает параметры оси (вызов функции GetAxlePar) и получает 0 NewUser Depot1 123456 1 0 12 12

Система добавляет в очередь команд склада на последнее место команду SendR (вызов функции SendStoreCom) и получает сообщение о том, что команда успешно принята - 0

Система запрашивает склад о результатах выполнения команды (вызов функции GetStoreMessage) и получает сообщение о том, что команда успешно выполнена – 1

Система добавляет в очередь команд склада на последнее место команду SendR (вызов функции SendStoreCom) и получает сообщение о том, что команда успешно принята - 0

Система запрашивает склад о результатах выполнения команды (вызов функции GetStoreMessage) и получает сообщение о том, что команда успешно выполнена – 1

Система добавляет в очередь команд склада на последнее место команду Term (вызов функции SendStoreCom) и получает сообщение о том, что команда успешно принята - 0

Система запрашивает склад о результатах выполнения команды (вызов функции GetStoreMessage) и получает сообщение о том, что команда успешно выполнена – 1.

Во всех последующих разделах будет подробно рассматриваться именно этот тестовый случай!

6.3 Описание процесса системного тестирования

Рассмотрим процесс системного тестирования:

Анализ. Тестируемая система анализируется (проверяется) на наличие определенных свойств, которым надо уделить особое внимание, и определяются соответствующие тестовые случаи.

Построение. Выбранные на стадии анализа тестовые случаи переводятся на язык программирования.

Выполнение и анализ результатов. Производится выполнение тестовых случаев. Полученные результаты анализируются, чтобы определить, успешно ли прошла система испытания на тестовом наборе.

Процесс запуска тестовых случаев и анализа полученных результатов должен быть подробно описан в тестовых процедурах.

Далее мы рассмотрим три различных подхода, которые используются при системном тестировании:

Ручное тестирование

Автоматизация выполнения и проверки результатов тестирования с помощью скриптов

Автоматическая генерация тестов на основе формального описания.

6.4 Ручное тестирование

Наиболее распространенным способом разработки тестов является создание тестового кода вручную. Такой способ создания тестов является наиболее гибким, однако производительность тестировщиков при создании тестового кода соизмерима с производительностью разработчиков при создании кода продукта, а объемы тестового кода часто бывают в 1 - 10 раз больше объема самого продукта.

В этом случае запуск тестов осуществляется вручную. Проверку, прошла ли тестируемая система испытания на заданном тестовом случае, тестировщик также осуществляет вручную, сравнивая фактические результаты журнала теста c ожидаемыми результатами, описанными в спецификации тестового случая.

Функции  dll-библиотеки обеспечивают обращение к серверу для получения информации о состоянии элементов комплекса и возвращают серверу информацию о функционировании системы. Значит, для моделирования состояния окружения (входных данных) необходимо создать специальный сервер. 
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Рис. 6‑3 Система и ее окружение (ручное тестирование)

Кроме того, необходимо сохранять получаемую от сервера информацию о функционировании системы (выходные данные) в журнале (Рис. 6‑3). 

При разработке тестов был использован следующий подход:

Состояние окружения задается в тесте (входные данные)

В тесте создается сервер

сервер по запросу от dll передает информацию о заданном состоянии окружения

сервер получает от dll информацию о функционировании системы

Получаемая информация сохраняется в журнале теста.

6.4.1 Подробное описание тестового случая №1

Ознакомление с настоящим пунктом полезно предварить  изучением п.7, содержащим описание ручного тестирования. Здесь рассматривается та часть теста на C#, которую вам придется написать самостоятельно при выполнении заданий. Приведенный пример был разработан в соответствии со спецификацией тестового случая N1. Для простоты будем считать, что события происходят последовательно в строго заданном порядке. Реально наша система представляет собой многопоточное приложение, поэтому мы не можем это гарантировать.


class Test1:Test {

override public void start()

{//Задаем состояние окружения (входные данные)

StoreStat="32"; //Поступил подшипник
RollerPar="0 NewUser Depot1 123456 1 12 1 1"; 

//статус обмена с терминалом подшипника (0 - есть подшипник) и его параметры

AxlePar="1 NewUser Depot1 123456 1 0 12 12";

//статус обмена с терминалом оси (1 - нет оси) и ее параметры

CommandStatus="0"; //команда успешно принята

StoreMessage="1"; //успешно выполнена

//Получаем информацию о функционировании системы

wait(“GetStoreStat”); //опрос статуса склада

wait(“GetRollerPar”);

//Получение информации о подшипнике с терминала подшипника

wait(“GetAxlePar”);

//Получение информации о оси с терминала оси

wait(“SendStoreCom”); //добавление в очередь команд склада на первое место

//команды GetR (получить из приемника в ячейку)

wait(“GetStoreMessage”);

//Получение сообщения от склада о результатах выполнения команды

//В результате первый подшипник должен быть принят

wait(“GetStoreStat”); //опрос статуса склада
wait(“GetRollerPar”);

//Получение информации о подшипнике с терминала подшипника

wait(“GetAxlePar ”);//Получение информации об оси с терминала оси

wait("SendStoreCom"); //добавление в очередь команд склада на первое место

//команды GetR (получить из приемника в ячейку)

wait(“GetStoreMessage”);

//Получение сообщения от склада о результатах выполнения команды

//В результате второй подшипник должен быть принят

//Задаем новое состояние окружения (входные данные)

RollerPar="1 NewUser Depot1 123456 1 12 1 1"; 

//статус обмена с терминалом подшипника (1 - нет подшипника) и его параметры

AxlePar="0 NewUser Depot1 123456 1 0 12 12";

//статус обмена с терминалом оси (0 - есть ось) и ее параметры

//Получаем информацию о функционировании системы

wait(“GetStoreStat”); //опрос статуса склада

wait(“GetRollerPar”);

//Получение информации о подшипнике с терминала подшипника

wait(“GetAxlePar”);//Получение информации об оси с терминала оси

wait("SendStoreCom");//Добавление в очередь команд склада на последнее место //команды SendR (ячейку на выход)

wait(“GetStoreMessage”);

//Получение сообщения от склада о результатах выполнения команды

//В результате первый подшипник для оси должен быть выдан

wait("SendStoreCom");//Добавление в очередь команд склада на последнее место //команды SendR (ячейку на выход)

wait(“GetStoreMessage”);

//Получение сообщения от склада о результатах выполнения команды

//В результате второй подшипник для оси должен быть выдан

wait("SendStoreCom");//Добавление в очередь команд склада на последнее место //команды Term (завершение команд выдачи)

wait(“GetStoreMessage”);

//Получение сообщения от склада о результатах выполнения команды

finish();

}
}

Рис. 6‑4 Пример фрагмента теста (вариант 1)

При разработке тестов не обязательно дожидаться каждого события, которое должно происходить в соответствии со случаем использования. Достаточно вызвать wait для событий, после наступления которых надо менять состояние окружения. В период ожидания наступления события, заданного в wait, может происходить любое количество других событий. Все эти события будут занесены в журнал. При необходимости ждать не первого, а n-го вызова можно вызывать wait с одним и тем же параметром n раз (например, в цикле). При таком подходе тест будет гораздо короче, например приведенный выше тест будет выглядеть следующим образом:


class Test1:Test

{

override public void start()

{

StoreStat="32";//Пришел подшипник
RollerPar="0 NewUser Depot1 123456 1 12 1 1";//его параметры
AxlePar="1 NewUser Depot1 123456 1 0 12 12";//нет оси
CommandStatus="0";//команда успешно принята

StoreMessage="1";//команда успешно выполнена

wait("SendStoreCom");//первый подшипник принят

wait("SendStoreCom");//второй подшипник принят

RollerPar="1 NewUser Depot1 123456 1 12 1 1";//больше нет подшипников

AxlePar="0 NewUser Depot1 123456 1 0 12 12";//есть ось
wait("SendStoreCom");//выдача подшипника
wait("SendStoreCom");//выдача подшипника
wait("SendStoreCom");//завершение выдачи

finish();}

}

Рис. 6‑5 Пример фрагмента теста (вариант 2)

6.4.2 Описание тестовых процедур

Тестовые процедуры - это формальный документ, содержащий описание необходимых шагов для выполнения тестового набора. В случае ручных тестов тестовые процедуры содержат полное описание всех шагов и проверок, позволяющих протестировать продукт и вынести вердикт PASS/FAIL. Процедуры должны быть составлены таким образом, чтобы любой инженер, не связанный с данным проектом, был способен адекватно провести цикл тестирования, обладая только самыми базовыми знаниями о применяющемся инструментарии.

6.4.2.1.1 Как запустить тест

Для того чтобы запустить тест, нужно:

В методе Class1.Main создать экземпляр нового класса и вызвать его метод start. Так как метод start является виртуальным, то можно обращаться к тестам, используя ссылку на тип Test. Это делается так:

Test t = new <ваш класс-потомок Test>;

t.start();

Собрать и запустить приложение.

6.4.2.1.2 Проверка результатов выполнения тестов (сравнение с ожидаемым результатом)

После завершения теста следует просмотреть текстовый журнал теста (..\SystemTesting\ManualTests\Tests\bin\Debug\log.log), чтобы выяснить, какая последовательность событий в системе была реально зафиксирована (выходные данные) и сравнить их с ожидаемыми результатами, заданными в спецификации тестового случая №1.

Как уже упоминалось, кроме журнала теста, создается еще и соответствующий журнал системы. В обоих журналах содержится информация о происходивших в системе событиях. Вы можете до того, как вручную сравнивать журнал теста с ожидаемыми результатами, заданными в спецификации тестового случая, использовать SystemLogAnimator (п.14) для визуализации соответствующего журнала системы и получить наглядное (в том числе ретроспективное) представление о том, как функционировала система. Это важно при разработке тестовых случаев, потому что, не зная в деталях, как работает система, можно написать неправильный тест. Необходимо научиться отличать, что вы в действительности обнаружили - ошибку в системе или результат работы неправильного теста.

6.4.3 Пример неправильного теста

Предположим, что вы во всех деталях не поняли Приложение 1 (FS) и неправильно составили спецификацию тестового случая №1 и тест. Например:

//Задаем состояние окружения (входные данные)

StoreStat="32"; //Поступил подшипник

…

//Получаем информацию о функционировании системы

wait(“GetStoreStat”); //опрос статуса склада

//Вместо того, чтобы получить информацию о подшипнике с //терминала подшипника мы хотим получить информацию об оси с //терминала оси

wait(“GetAxlePar”);

...

В журнале теста мы увидим следующую информацию:

CALL: GetStoreStat 0

RETURN: 32

CALL: GetRollerPar

RETURN: 0 NewUser Depot1 123456 1 12 1 1

CALL: GetAxlePar

RETURN: 1 NewUser Depot1 123456 1 0 12 12

…

Главное - суметь разобраться и исправить спецификацию тестового случая и тест, если вы сами допустили ошибку.

6.4.4 Задание 3

Для тестового случая №1 необходимо составить полный список всех возможных альтернативных путей (см. подраздел «Список альтернативных путей») и разработать соответствующие тесты.

Кроме того, необходимо:

выбрать случай использования на основании дерева решений (..\SystemTesting\Decision Tree.vsd)

составить пошаговое описание выбранного случая использования

учесть все альтернативные пути

составить спецификации тестовых случаев

разработать соответствующие тестовые случаи (тесты)
составить тестовые отчеты (Рис. 4‑2).

6.5 Автоматизация тестирования с помощью скриптов

Общая тенденция последнего времени предусматривает максимальную автоматизацию тестирования, которая позволяет справляться с большими объемами данных и тестов, необходимых для современных продуктов.

В этом случае запуск тестов и проверка того, что тестируемая система прошла испытания на заданном тестовом случае, будет осуществляться автоматически.

Здесь еще раз повторим, что функции в dll были переписаны так, что они обращаются к серверу для получения информации о состоянии элементов комплекса и возвращают серверу информацию о функционировании системы. Для задания состояния окружения (входных данных) необходимо обратиться к серверу и передавать ему необходимую информацию. В данном случае был разработан сервер, который кроме приема и передачи информации еще осуществляет проверку правильности поведения системы (Рис. 6‑6). Он представляет собой модель тестируемой системы. В рамках модели заданы ожидаемые результаты и осуществляется сравнение выходных данных с ожидаемыми результатами. Хотя считалось, что разработанная модель является корректной, полной и непротиворечивой, у вас есть реальная возможность найти ошибки и в самой модели.

При разработке тестов был использован следующий подход:

Состояние окружения задается в тесте (входные данные)

Разработанный сервер:

передает информацию о заданном состоянии окружении по запросу от dll

получает от dll информацию о функционировании системы (выходные данные)

сравнивает выходные данные с ожидаемым результатом.

Получаемая информация сохраняется в журнале теста

Строится таблица покрытия FS (..\SystemTesting\ScriptTests\Logs\summary.html).
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Рис. 6‑6 Система и ее окружение (скрипты)

6.5.1 Подробное описание тестового случая №1

Изучение настоящего пункта полезно предварить ознакомлением с п.8, в котором описан подход к автоматизации тестирования с помощью языка скриптов. Здесь рассматривается тест на tcl, подобные тесты необходимо будет писать самостоятельно при выполнении заданий. Приведенный пример был разработан в соответствии со спецификацией тестового случая N1. Для простоты будем считать, что события происходят последовательно в строго заданном порядке. Реально наша система - многопоточное приложение, поэтому такое условие далеко не всегда можно гарантировать.

source bin\\srv.tcl //запуск сервера
global StoreStat //статус склада
global RollerPar //терминал подшипника
global AxlePar
 //терминал оси
global CommandStatus //возвращаемое значение функции //SendStoreCom о результатах получения команды

global StoreMessage //сообщение от склада о результатах //выполнения команды

global rollers_found //1 (можно подобрать подходящий подшипник) //или 0 (нельзя)

global fds //строка для графы “Покрытие FS” в итоговой

//таблице результатов тестирования (по умолчанию – Default)

global last_command
//последняя команда тестируемой системы

global allowed
//список разрешенных команд

set fds "1.a.1; 1.a.4; 2.a; 2.c; 3.a; 4.c" //покрывает заданные //пункты FS

StartTest Warehousetest0001 //запуск теста
Timeout 30 // процесс тестирования будет прерван через 30сек

//Задаем состояние окружения (входные данные)

set StoreStat 32 //Поступил подшипник
set RollerPar "0 NewUser Depot1 123456 1 12 1 1"

//статус обмена с терминалом подшипника (0 - есть подшипник) и //его параметры

set AxlePar "1 NewUser Depot1 123456 1 0 12 12"

//статус обмена с терминалом оси (1 - нет оси) и ее параметры

set CommandStatus 0 //команда успешно принята

set StoreMessage 1 //команда успешно выполнена

set rollers_found 1 //можно подобрать подходящий подшипник

//Получаем информацию о функционировании системы

Wait "GetStoreStat *" 0 1

//Неограниченное время (0) ждем получения команды (“опрос //статуса склада”) и если команда не получена, то будет //зафиксирована ошибка (1)

Wait "GetRollerPar" 0 1

//Неограниченное время (0) ждем получения команды (“получить //информацию о подшипнике с терминала подшипника”) и если //команда не получена, то будет зафиксирована ошибка (1)

set allowed [list "GetAxlePar"]

//Получение команды “получить информацию об оси с терминала оси” //разрешено и не должно вызвать ошибку

Wait "SendStoreCom 1 *" 10 1

//В течение 10 секунд ждем получения команды (“добавить в очередь //команд склада на первое место команду GetR (1 - получить из //приемника в ячейку)” и если команда за это время не получена, //то будет зафиксирована ошибка (1)

Wait GetStoreMessage 0 1
//Неограниченное время (0) ждем получения команды (“получить //сообщение от склада о результатах выполнения команды”) и если //команда не получена, то будет зафиксирована ошибка (1)

//В результате первый подшипник должен быть принят

set allowed [list]

Wait "GetStoreStat *" 0 1

//Неограниченное время (0) ждем получения команды (“опрос //статуса склада”) и если команда не получена, то будет //зафиксирована ошибка (1)

Wait GetRollerPar 0 1

//Неограниченное время (0) ждем получения команды (“получить //информацию о подшипнике с терминала подшипника”) и если //команда не получена, то будет зафиксирована ошибка (1)

set allowed [list "GetAxlePar"]

//Получение команды “получить информацию об оси с терминала оси” //разрешено и не должно вызвать ошибку

Wait "SendStoreCom 1 *" 10 1

//В течение 10 секунд ждем получения команды (“добавить в очередь //команд склада на первое место команду GetR (1 - получить из //приемника в ячейку)”) и если команда за это время не получена, //то будет зафиксирована ошибка (1)

Wait "GetStoreMessage" 0 1

//Неограниченное время (0) ждем получения команды (“получить //сообщение от склада о результатах выполнения команды”) и если //команда не получена, то будет зафиксирована ошибка (1)

//В результате второй подшипник должен быть принят

//Задаем новое состояние окружения (входные данные)

set StoreStat 32 //Поступил подшипник
set RollerPar {1 NA NA 0 0 0 0 0}

//статус обмена с терминалом подшипника (1 - нет подшипник) и //его параметры

set AxlePar "0 NewUser Depot1 123456 1 0 12 12"

//статус обмена с терминалом оси (0 - есть ось) и ее параметры

//Получаем информацию о функционировании системы

Wait "GetStoreStat *" 0 1

//Неограниченное время (0) ждем получения команды (“опрос //статуса склада”) и если команда не получена, то будет //зафиксирована ошибка (1)

Wait "GetRollerPar" 0 1

//Неограниченное время (0) ждем получения команды (“получить //информацию о подшипнике с терминала подшипника”) и если //команда не получена, то будет зафиксирована ошибка (1)

Wait GetAxlePar 0 1

//Неограниченное время (0) ждем получения команды (“получить //информацию о оси с терминала оси”) и если команда не получена, //то будет зафиксирована ошибка (1)

//В результате должна прийти ось

Wait "SendStoreCom 2 *" 10 1

//В течение 10 секунд ждем получения команды (“добавить в очередь //команд склада на последнее место команду SendR (2 - ячейку на //выход)”) и если команда за это время не получена, то будет //зафиксирована ошибка (1)

if {![string compare $last_command "SendStoreCom 2 9 9 9 0 0 1"]} {

//была послана команда выдать первый подшипник для оси

Wait "GetStoreMessage" 0 1

//Неограниченное время (0) ждем получения команды (“получить //сообщение от склада о результатах выполнения команды”) и если //команда не получена, то будет зафиксирована ошибка (1)

Wait "SendStoreCom 2 9 9 9 0 1 1" 0 1

//Неограниченное время (0) ждем получения команды (“добавить в //очередь команд склада на последнее место команду SendR (2 - //ячейку на выход)”) и если команда за это время не получена, то //будет зафиксирована ошибка (1)

//послали команду выдать второй подшипник

}

if {![string compare $last_command "SendStoreCom 2 9 9 9 0 1 1"]} {

//если была послана команда выдать второй подшипник для оси

Wait "GetStoreMessage" 0 1

//Неограниченное время (0) ждем получения команды (“получить //сообщение от склада о результатах выполнения команды”) и если //команда не получена, то будет зафиксирована ошибка (1)

Wait "SendStoreCom 2 9 9 9 0 0 1" 0 1

//Неограниченное время (0) ждем получения команды (“добавить в //очередь команд склада на последнее место команду SendR (2 - //ячейку на выход)”) и если команда за это время не получена, то //будет зафиксирована ошибка (1)

//послали команду выдать первый подшипник

}

Wait "GetStoreMessage" 0 1

//Неограниченное время (0) ждем получения команды (“получить //сообщение от склада о результатах выполнения команды”) и если //команда не получена, то будет зафиксирована ошибка (1)

Wait "SendStoreCom 20 *" 0 1

//Неограниченное время (0) ждем получения команды (“добавить в //очередь команд склада на последнее место команду Term (20 - //завершение команд выдачи)”) и если команда не получена, то //будет зафиксирована ошибка (1)

Wait "GetStoreMessage" 0 1

//Неограниченное время (0) ждем получения команды (“получить //сообщение от склада о результатах выполнения команды”) и если //команда не получена, то будет зафиксирована ошибка (1)

EndTest

Рис. 6‑7 Тест на tcl/tk
6.5.2 Описание тестовых процедур

6.5.2.1.1 Как запустить тест

Запустить run.bat. В файле run.bat запускается tests.bat. Файл tests.bat содержит команды запуска тестов и установки необходимого состояния базы данных:

osql -H <Host > -S <Server > -d WarehouseTCL -U sa -P sa -i sql\ClearDB.sql

//Вызывается скрипт ClearDB.sql из подкаталога sql. Предполагается, //что SQL Server выполняется на машине <Host> и называется //<Server>. Эти параметры были настроены автоматически при //установке практикума.

//База данных называется WarehouseTCL. Если названия отличаются, //необходимо заменить параметры командной строки утилиты OSQL:

//
-h <host> - задает имя хоста, на котором выполняется SQL Server

//
-s <server> - имя сервера
//
-d <db> - имя базы данных

//
-u <username> - имя пользователя

//
-p <password> - пароль
//
-i <script> - имя скрипта SQL.

bin\launcher tests\warehousetest0001.tcl

//Вызывается тест warehousetest0001.tcl
copy log.txt logs\warehousetest0001.txt

//Файл log.txt (лог тестируемой системы) копируется в файл //warehousetest0001.txt. Для исключения части тестов из набора //достаточно закомментировать соответствующие строки (команда //REM).

6.5.2.1.2 Проверка результатов выполнения тестов (сравнение с ожидаемым результатом)

В этом случае запуск тестов и проверка того, что тестируемая система прошла испытания на заданном тестовом случае, осуществляется автоматически и результаты представляются в виде таблицы; здесь, как и в предыдущем случае создается журнал теста, а также можно использовать SystemLogAnimator (п.8) для визуализации журнала системы.

6.5.3 Пример неправильного теста

Рассмотрим тот же пример неправильного теста, как и в случае ручного тестирования:

При поступлении подшипника вместо того, чтобы получить информацию о подшипнике с терминала подшипника, мы хотим получить информацию об оси с терминала оси.

Убедитесь, что система функционирует по-другому.

6.5.4 Задание 4

Нужно выполнить те же задания, что и для ручного тестирования.

6.6 Автоматическая генерация тестов на основе формального описания

Тесты составляются на основе спецификации требований. При формулировании требований на естественном языке существует проблема их различных толкований. Одним из способов избежать этого является применение формальных языков для описания структуры и поведения системы (UML, SDL, MSC). Кроме того, описание требований на формальном языке является формальным описанием тестовых случаев, на основе которого можно генерировать тестовый код. В практикуме для создания тестов будет использоваться язык диаграмм взаимодействия (Message Sequence Charts, MSC - п.11). В этом случае под тестом мы будем понимать его представление в виде MSC-диаграммы.

В Практикуме для реализации тестирования используется учебная система автоматизации тестирования TAT – Test Automation Training. На вход система принимает формальное описание тестов в виде MSC диаграмм (в текстовом формате MSC PR). На основе этих MSC диаграмм и конфигурационного файла (в формате XML), который описывает интерфейс тестируемой системы, генерируется тест на С#. (Интерфейс тестируемого приложения (Application Under Test - AUT) содержит сигналы, сообщения, транзакции, которые система может посылать тестовому окружению или может принимать от тестового окружения). Для запуска системы с этим тестом необходимо написать Wrapper, который транслирует сигналы от теста к системе и наоборот.

Таким образом, методика тестирования системы с помощью TAT выглядит следующим образом:

Написать Wrapper для тестируемой системы

Создать файл конфигурации

Создать формальное описание тестов в виде MSC-диаграмм

Нарисовать MSC-диаграммы в MS Visio

Сгенерировать с помощью макроса тестовый файл в формате MPR

Настроить в ConfigTAT проект теста (указать пути) или набора тестов

Запустить тест или набор тестов

Проанализировать получаемые log-файлы.

В данном случае wrapper и файл конфигурации (первые два пункта методики) уже созданы, поэтому вам необходимо будет выполнить только п.3-6.

В рассматриваемом подходе не только запуск тестов и проверка результатов прогона тестового случая будут осуществляться автоматически, но и сам тестовый код будет генерироваться автоматически на основе MSC-диаграммы (Рис. 6‑8).

[image: image11.png]wsc:
s visio IS Warpoc
T Configsic
ueR
Conte y— sic Tocm C#
Wrapper
Jor Tor recta

chcTeml





Рис. 6‑8 Система и ее окружение (автоматическая генерация)

При разработке тестов был использован следующий подход (Рис. 6‑9):

Когда реализуется определенное событие, модель посылает сигнал запроса состояния к тестовому окружению

Состояние окружения задается в тесте (входные данные) в виде параметров сигналов. Тест возвращает состояние окружения (StoreStat, AxlePar, RollerPar, StoreMessage, CommandStatus), посылая модели сигнал с параметрами в соответствии с запросом

Получаемая информация сохраняется в журнале теста.
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Рис. 6‑9 Взаимодействие теста и модели (MSC-диаграмма)

6.6.1 Подробное описание тестового случая №1

Изучение материала настоящего пункта полезно предварить ознакомлением с п.9, содержащим описание подхода к автоматической генерации тестов на основе MSC. Здесь рассматривается тест, представляющий собой MSC-диаграмму, созданную в Visio. Подобные тесты необходимо будет разработать (нарисовать) самостоятельно при выполнении заданий. Приведенный пример был разработан в соответствии со спецификацией тестового случая №1 (Рис. 6‑10).

[image: image13.png]Test Model
(CCATATITesthaotwarshousetesoD!
aatinti —
G ORRR0)

e

e | poammna,
GetRollrParfe<Hiamor AA"eno Ner P Rty
=2 T =
GetuePartesl D 9.0F DF.) r

commpmeor | R A

coraga onanaa
e SERHES S )

Bompens ronana
aotasnena
onanaa” Tonyure

ot

T,
G ORRR0)

coosugzer,uro | e
e N, el aion . feno e

nmwna__|
}Iﬂé

cootugzer, uto
| nectymun stopoi

esePar R DOFDF.)

Ty
cosuame or

Wotaen

Prrvieren v
s o | g actatners

Tonyate >

e SERHES S )

=
e o
ompaene 2 G ORRR0) contuaar.aro

1
e, |

st e S gy |/

i
i Al e contmaer, o
asnaem oot Y ety estiliaos et ot
-ompaETa- y) AL RE L Heotixoaumo
neprun neaotpan 2
pei TR Con BRI
o sucic. \

SendStore ComResi) inenonesyerca amn
N e
[eer

T
ceSorter Sosres()

SR Cam T 3501 N

G
nepautt

J— N

e SERHES S )

d | peopmurarax

W

Fopon ARE

ot STl { Sz wgem
imeie e
T L__nomum

ceSorer Sosres()

T
Fopot

e

R ey

et SrHeE S asHeE)

R e

S| et SrHeE S asHeE)

a

fimpi

oo
{wcumngyTom
4 “aaphoms
[





Рис. 6‑10 Тестовый случай №1
6.6.2 Описание тестовых процедур

6.6.2.1.1 Как сгенерировать и запустить тест

Изучение материала настоящего пункта полезно предварить ознакомлением с п.12, 13,содержащими описание использования MS Visio для генерации MPR файлов и описание конфигурирования - ConfigTAT. 

На данном этапе используется тест, представляющий собой MSC-диаграмму, созданную в Visio. Дальнейшие действия описываются следующей методикой: 

1) Запустить Microsoft Visio.

2) Загрузить Stensil (File->Open->MSC.VSS или File->Open Stensil ->MSC.VSS). Visio выдаст предупреждение о том, что данный stensil содержит макросы. На предупреждение следует ответить “Enable macros”.

3) Открыть существующий тестовый случай №1 – Warehousetest0001 (..\SystemTesting\TATTests\Tests\Tests\Тests.vsd).

4) Для генерации MPR вызвать следующий макрос: Tools->Macros->MSC->Module1->Parse. В указанной папке будет создан MPR-файл с именем, соответствующим имени текущей страницы в Visio ( ..\SystemTesting\TATTests\Tests\WarehouseTest1\warehousetest0001.mpr) 

5) Запустить ConfigTAT

6) В меню File -> Open выбрать тестовый случай N1

7) Выбрать настройки –  установить по умолчанию (Set ALL to default)

8) Запуск – генерация и запуск теста (Run ALL).

6.6.2.1.2 Проверка результатов выполнения тестов (сравнение с ожидаемым результатом)

В этом случае запуск тестов и проверка того, что тестируемая система прошла испытания на заданном тестовом случае осуществляется автоматически, как и в предыдущем случае создается журнал теста, а также можно использовать SystemLogAnimator (п.14) для визуализации журнала системы.

Для просмотра протоколов тестирования надо использовать группу “Test Logs” ConfigTAT и можно просматривать:

протокол тестирования в виде html страницы (HTML log)

протокол тестирования в виде txt файла (Text log)

протоколы в формате mpr (отдельный протокол для каждого testcase-а и каждой итерации теста), которые можно открыть в программе Telelogic нажатием кнопки “View” (MPR logs).

6.6.3 Пример теста с ошибкой

На Рис. 6‑11 представлена диаграмма  теста с ошибкой. Используя FS, необходимо объяснить причину некорректности тестового случая.
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Рис. 6‑11 Тест с ошибкой

6.6.4 Задание 5

Для случая автоматического тестирования на основе MSC-диаграмм нужно повторить те же задания, что и для ручного тестирования.

7 Описание ручного тестирования

Реализация выбранного подхода для ручного тестирования приводится в Class1.cs (..\SystemTesting\ManualTests\Tests\Class1.cs).

Все классы входят в пространство имен Tests. Это пространство имен содержит следующие классы:

Class1 – главный класс приложения. Содержит статический метод Main, вызываемый при запуске

Test – абстрактный (abstract) класс, реализующий общую для всех тестов функциональность. Содержит следующие методы:

public Test() – конструктор. Создает серверный сокет и запускает сервер

protected void wait(string st) – ожидает получения от dll вызова, начинающегося со строки st

protected void finish() – обрабатывает последний запрос от dll и закрывает серверный сокет

virtual public void start() – запускает тест. В каждом конкретном тесте переопределяется.

Кроме того, класс Test содержит пять protected полей типа string:

StoreStat - статус склада

AxlePar - терминал оси

RollerPar - терминал подшипника

CommandStatus - возвращаемое значение функции SendStoreCom

StoreMessage - сообщение от склада.

7.1 Как создать свой тест

Для создания нового теста необходимо выполнить следующие действия:

Создать новый класс, являющийся потомком Test

Переопределить в нем метод start(), чтобы реализовать функциональность теста:

задать состояние окружения (StoreStat, AxlePar, RollerPar, StoreMessage, CommandStatus)

ждать, когда произойдет определенное событие (вызов wait в котором надо задать строку для выхода из состояния ожидания)

задать новое состояние окружения и т.д.

Тест должен завершаться вызовом finish().

В общем виде тест выглядит так:

override public void start()

{
<задание переменных>

wait(<строка>);

<задание переменных>

wait(<строка>);

….

finish();

}

8 Автоматизация тестирования с помощью скриптов

8.1 Как создать свой тест

В данном случае используется тот же принцип, что и при ручном тестировании:

задать состояние окружения (StoreStat, AxlePar, RollerPar, StoreMessage, CommandStatus)

ждать, когда в системе произойдет определенное событие

задать новое состояние окружения

и т.д.

Каждый тест должен быть представлен в следующем виде:

ЗАГОЛОВОК

БЛОК

Wait <условие>

БЛОК

Wait <условие>

.....

EndTest

Опишем эти элементы более подробно.

8.1.1 Описание заголовка

Заголовок теста состоит из:

команды запуска сервера

команд global, устанавливающих доступ к глобальным переменным состояния окружения

команды StartTest, задающей имя теста (оно не обязательно должно совпадать с именем файла).

source bin\\srv.tcl

//запуск сервера
global StoreStat 

//статус склада
global AxlePar

//терминал оси
global RollerPar

//терминал подшипника
global CommandStatus
//возвращаемое значение функции SendStoreCom

global StoreMessage

//сообщение от склада

global rollers_found

//1 (можно подобрать подходящий //подшипник) или 0 (нельзя)

global fds
//строка для графы “Покрытие FDS” в итоговой таблице

//результатов тестирование (по умолчанию – Default)

global last_command

//последняя команда тестируемой системы

global allowed  //список разрешенных команд, их получение не должно //вызывать ошибку

StartTest <имя>

//запуск теста

8.1.2 Описание блока

Каждый блок устанавливает значения одной или более переменных окружения. Например:

Set StoreStat 32

…

8.1.3 Описание Wait

Команда Wait используется для изменения состояния тестового окружения в ответ на действия системы.

При вызове процедуры Wait скрипт входит в состояние ожидания. Обращение со стороны системы приводит к завершению состояния ожидания. Если условие выполнено, то ответ на это обращение будет сформирован на основе следующего блока, иначе – на основе предыдущего.

Wait <команда> <время> <обязательно>

<команда> определяет команду системы, которая приведет к переходу в следующий блок. Можно использовать стандартные символы подстановки *, ?, []

<время> определяет время ожидания. Если задать 0, то время не ограничено

<обязательно> дает возможность не формировать ошибку, если за заданное время требуемая команда не была получена. Если задана 1, то в случае неполучения команды будет сформирована ошибка, а если 0, то ошибки не будет.

Примеры использования:

Wait ZZZZZZZ 10 0 – ждать 10 секунд (команда ZZZZZZZ является недопустимой и не может быть получена)

Wait “GetStoreStat *” 0 1 – ждать команды GetStoreStat с любыми параметрами неограниченное время

Wait “SendStoreCom 2 *” 10 1 – ждать команды SendStoreCom с первым параметром 2 и произвольными остальными параметрами в течение 10 секунд, если она не получена, будет зафиксирована ошибка

Wait ZZZZZZZ 0 0 – бесконечное ожидание.

Так как ожидание в процедуре Wait прерывается только при поступлении запроса от системы, то в случае отсутствия запросов (система зависла и ничего не делает) тест также останавливается. Для предотвращения такой ситуации используется следующая команда: Timeout <время>

<время> определяет число секунд, после которого процесс тестирования будет прерван. При этом в журнал теста будет занесено сообщение TIMEOUT. Срабатывание тайм-аута приводит к завершению теста. Команда Timeout 0 отменяет ограничение времени.

8.1.4 Описание allowed

Рассмотрим переменную allowed более подробно. Она содержит список тех команд, получение которых разрешено и не должно вызывать ошибку. Например, в следующем примере вызов GetAxlePar не спровоцирует ошибку:

Set StoreStat 32

Wait “GetStoreStat *” 0 1

Wait “GetRollerPar” 0 1

Set allowed [list “GetAxlePar”]

Wait “SendStoreCom 1 0 0 1 0 0 0” 0 1

Однако ошибка все же возникнет, если данная команда в данной ситуации является недопустимой. Несмотря на то, что проверка реализована в скрипте srv.tcl, использование команды Wait и списка allowed могут ужесточить проверку. Значение по умолчанию для allowed – “*”. В этом случае проверку проходят все команды. Вход в процедуру Wait вызывает расширение списка allowed до момента выхода из нее, так что ожидаемая команда системы всегда проходит проверку на принадлежность списку allowed. В списке allowed можно задействовать символы подстановки.

9 Описание автоматической генерации MSC тестов 

9.1 Как создать свой тест

В данном случае под тестом мы будем понимать его представление в виде MSC-диаграммы. В качестве объектов мы будем рассматривать тест (Test) и тестируемую систему (Model). Обмен сообщениями между тестом и моделью происходит следующим образом  (Рис. 9‑1):

Когда в системе происходит определенное событие, она запрашивает состояние окружения, посылая сигнал тестовому окружению

Тест возвращает состояние окружения (StoreStat, AxlePar, RollerPar, StoreMessage, CommandStatus), посылая модели сигнал с параметрами в соответствии с запросом.
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Рис. 9‑1 Взаимодействие теста и модели

10  Структура и описание содержимого каталогов
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Папка IntegrationTesting содержит проект Visual Studio .NET с примером интеграционного теста.

Папка ModuleTesting содержит проект Visual Studio .NET с примером модульного теста.
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В папке SystemTesting\ManualTests содержится проект Visual Studio .NET с примерами системных ручных тестов.

В папке SystemTesting\ScriptsTests содержатся примеры тестов с использованием скриптов:

\bin – содержит программу launcher.exe, файл srv.tcl и вспомогательные скрипты header.tcl и footer.tcl, используемые для формирования структуры html-отчета. Программа launcher.exe запускает тестируемую систему и тестовый скрипт на выполнение, а после завершения теста завершает выполнение системы.

\logs – log-файлы пройденных тестов (*.log), log-файлы  тестируемой системы (*.txt) и общий отчет summary.html
\model – исполнимые файлы тестируемой системы

\sql – SQL скрипты для установки заданного состояния базы данных

\tests – тестовые скрипты на языке TCL.

Папка SystemTesting\TATTests содержит:

\ConfigTAT – программа ConfigTAT для настройки и запуска тестов TAT:

\tat – система автоматизации тестирования TAT

\Tests\config\config.xml – xml файл, описывающий тестируемую систему (AUT), тестовое окружение и сигналы между ними

\Tests\Model – тестируемая система application under test

\Tests\mpr – mpr-файлы, описывающие тесты

\Tests\SQLScripts – sql-скрипты для подготовки базы данных к конкретному тесту

\Tests\Tests – stencil для Visio и MSC-диаграммы тестов в Visio

\Tests\WareHouseTest№ - рабочие папки тестов

\Tests\ *.tcf, tests.ltc – сохраненные конфигурации тестов и Testsuite-а для ConfigTAT
Папка SysLogAnimator содержит основные файлы: библиоткеа DirectX, запускаемый файл LogAnimator.exe и конфигурационный файл LogAnimator.cfg.

Папка SysLogAnimator\Data содержит необходимые для работы аниматора графические файлы.

11 Описание MSC
Язык диаграмм взаимодействия (Message Sequence Charts, MSC) - это язык описания поведения системы в виде последовательности событий. События могут относиться к отдельным компонентам системы, к взаимодействиям между компонентами системы либо к взаимодействию между системой и ее окружением. Основное назначение диаграмм взаимодействия – описание последовательностей допустимых взаимодействий между компонентами системы и системой и ее окружением. Диаграммы изображаются в графическом виде, но существует также текстовая форма MSC-диаграмм. Обе формы переводятся взаимно однозначно друг в друга.

Разновидности диаграмм взаимодействия используются при разработке систем реального времени с 60-х годов. Особое распространение диаграммы взаимодействия получили в области разработки телекоммуникационных систем. Язык диаграмм взаимодействия стандартизован в 1992 г. Международным Телекоммуникационным Союзом (ITU-T) (Рекомендация Z.120 1992). В настоящее время принята новая, значительно расширенная версия стандарта (Рекомендация Z.120 1996.)

11.1.1 Основные понятия

Диаграмма взаимодействия описывает последовательности событий, происходящих с набором объектов (системой взаимосвязанных компонентов). Дополнительно каждая система рассматривается как открытая, т.е. подразумевается наличие некоторого окружения системы, с которым система взаимодействует. Окружение также может задаваться в виде отдельного объекта.

Основным понятием диаграммы взаимодействий является трасса объекта. Для каждого объекта на диаграмме имеется отдельная вертикальная ось. На этой оси откладываются события, имеющие отношение к данному объекту. Считается, что все объекты существуют одновременно и последовательности событий объектов развиваются параллельно. При описании объекта используются стартовый (прозрачный прямоугольник) и конечный (черный прямоугольник) символы объекта, обозначающие соответственно начало и конец описания объекта в данной MSC-диаграмме.

Взаимодействие между объектами (а также между объектом и окружением системы) осуществляется только при помощи обмена сообщениями (Рис. 11‑1).

Сообщение моделирует взаимодействие (т.е. обмен информацией) между двумя объектами системы или между объектом и окружением системы. С точки зрения системы, взаимодействие между двумя объектами разбивается на два сопряженных события: посылка сообщения одним объектом и прием сообщения другим объектом (Рис. 11‑1). Сообщения, приходящие из окружения системы, моделируются одним событием приема сообщения, а события, посылаемые в окружение, моделируются одним событием посылки сообщения. Сообщение имеет имя. Имя сообщения задает тип взаимодействия. Диаграмма может описывать несколько обменов сообщениями с одинаковым именем. Для уникальной идентификации конкретного обмена предусмотрен так называемый уникальный идентификатор обмена (message instance name), однако он используется только в текстовом представлении для снятия неоднозначности в описании сопряженных событий у различных объектов. В графическом представлении такой проблемы не возникает, так как сопряженные события представляются различными концами одного и того же графического объекта (стрелки от трассы одного объекта к трассе другого).
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Рис. 11‑1 Пример взаимодействия между объектами в MSC

Дополнительно, язык диаграмм взаимодействия позволяет описывать передачу информации в сообщении (Рис. 11‑2

 REF _Ref52876297 \h 
 \* MERGEFORMAT Рис. 11‑1 Пример взаимодействия между объектами в MSC). С сообщением может быть связан список параметров. Каждый параметр моделирует передачу конкретной информации от одного объекта к другому. Язык диаграмм взаимодействия не определяет семантику параметров сообщения.
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Рис. 11‑2 Передача параметров сообщений

MSC-диаграммы позволяют создавать более сложные описания поведения системы с помощью специальных операторов. В MSC’96 используется четыре типа операторов:

alt – альтернативный оператор,

par – параллельный оператор,

loop – итерация,

opt – опциональная область.

Графически операторные конструкции изображаются в виде прямоугольника с пунктирными линиями в качестве разделителей. Ключевое слово оператора располагается в левом верхнем углу.

Альтернативная композиция (Рис. 11‑3) позволяет задавать альтернативное выполнение секций MSC-диаграммы. Только одна альтернатива может быть реализована.
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Рис. 11‑3 Альтернатива

Операция par имеет структуру, аналогичную конструкции alt (Рис. 11‑3), и определяет параллельное выполнение секций. Это означает, что все события внутри параллельных секций будут выполнены. Единственным ограничением является то, что порядок событий в каждой секции будет сохранен.

Конструкция loop (Рис. 11‑4) имеет несколько форм. Наиболее общая форма – loop <n, m>, где n и m - натуральные числа. Это означает, что конструкция может быть выполнена от n до m раз. Вместо натурального числа может использоваться ключевое слово inf, обозначающее бесконечность.
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Рис. 11‑4 Цикл

Оператор opt  имеет структуру, аналогичную loop, но без операндов, и обозначает то же, что и оператор alt с пустой MSC  в качестве второго операнда.

Одним из важных понятий в MSC является условие или состояние. Состояние – это особое событие на трассе объекта. В отличие от прочих событий, одно и то же состояние может разделяться одним, двумя и более объектами. По числу объектов на диаграмме, разделяющих некоторое состояние, различают глобальные состояния (общее для всех объектов), разделяемые состояния (разделяемые несколькими, но не всеми объектами) и локальные состояния (разделяемые единственным объектом). Если два объекта разделяют одно и то же состояние, то сопряженные события приема и посылки сообщений должны происходить либо оба до соответствующего состояния, либо оба после соответствующего состояния.
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Рис. 11‑5 Состояние (условие)

Основной недостаток стандартной MSC - невозможность описать отношения данных в параметрах сообщения. Эта проблема решается с использованием некоторого расширения стандартного MSC - mMSC (macro MSC). Основные из этих расширений включают в себя:

Макроподстановки (Рис. 11‑6). Они позволяют создавать множество 

MSC-диаграмм с одинаковой структурой и разными параметрами сообщения, циклами и т. п. Макроподстановки начинаются с символа # и могут быть константами или функциями. Функции, кроме названия, содержат параметры, заключенные в скобки.
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Рис. 11‑6 Макроподстановки

Типы макроподстановок описываются в определенном файле, и на основе этой информации вместо них подставляются конкретные значения.

Временные ограничения служат для указания времени посылки/приема сообщения, его длительности и типа (синхронное с явно заданным моментом выполнения, асинхронное). Время может задаваться относительно начала работы (абсолютное), относительно предыдущего сообщения (относительное) или относительно метки. На (Рис. 11‑7) сообщение M01 должно отправиться через 5 единиц времени, в течение 5 единиц после получения сообщения M00 (указано с помощью метки).
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Рис. 11‑7 Использование времени

11.1.2 Применение MSC-диаграмм для описания поведения моделей

Благодаря своему главному преимуществу – ясному графическому представлению, которое дает интуитивное понимание поведения описываемой системы, MSC-диаграммы широко применяются для различных целей:

Для определения требований

Как спецификация интерфейсов

Как спецификация взаимодействия процессов

Как базис для генерации тестов

Для документации

Для объектно-ориентированного анализа и разработки.

Хотя изначально MSC-диаграммы предназначались для описания телекоммуникационных систем, сейчас они с успехом применяются и в других областях.

11.1.3 Обработка MSC-диаграмм

В случае достаточно сложных систем могут быть обнаружены ошибки, возникшие как при создании диаграммы, так и при проектировании тестируемой системы. Исправление тех же ошибок, если они будут обнаружены на более позднем этапе жизненного цикла продукта, потребует гораздо больших затрат.

11.1.4 Проверка MSC-диаграммы на полноту

Большинство систем или их частей можно в том или ином виде представить с помощью механизма state-машин. Тогда каждому состоянию системы на диаграмме будет соответствовать условие – конструкция condition. Для каждого события диаграммы (под событием будем понимать сообщение или действие – action) можно составить множество всех состояний, которые могут непосредственно предшествовать ему (предусловия). В этом случае проверка на полноту MSC-диаграммы будет заключаться в проверке, все ли возможные случаи предусловий для каждого события представлены в ней. Если это не так, то, возможно, диаграмма не описывает полностью все возможные сценарии работы системы, и множество тестов, сгенерированных по этой диаграмме, будет неполным.

12 Использование Ms Visio для генерации MPR-файлов

Разработанный набор утилит предназначен для:

преобразования MSC-диаграмм в формат MPR

проверки правильности подключения сигналов

загрузки комментариев.

Утилита поддерживает следующие типы конструкций:

Instance

Instance End

Message

Action

Comment

Coregion

Text

Condition

Reference

Block(Alt, Par, Loop, Opt).

При разработке диаграмм соединение объектов осуществляется при помощи Connector Point. Если какая-либо конструкция языка не будет присоединена, то будет выдано соответствующее сообщение об ошибке, “неправильный” элемент будет выделен красным цветом, а  MPR-файл генериться не будет.
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Исключение составляет элементы: Block, Condition, Reference и Text .

12.1 Описание элементов

Instance  [image: image26.png]


 представляет собой один из взаимодействующих объектов. Необходимо задать имя данного элемента. После завершения приема/выдачи всех сигналов к Instance присоединяется блок Instance End. Для увеличения длины Instance TimeLine, его необходимо выделить и увеличить длину, используя Control. [image: image27.png]
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 самостоятельно не используется, применяется только совместно с конструкцией Instance. Используется для сигнализации того, что данный объект закончил принимать/посылать сигналы.
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 событие/сообщение, представляет собой взаимодействие между объектами (Instances). Необходимо задать имя сообщения и параметры (если они необходимы). Messages должны быть присоединены к Instance с помощью Connector Points. Messages без имени не обрабатываются, и выдается сообщение об ошибке.
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 используется для отражения события, выполненного в рамках одного Instance. Блок необходимо присоединить с помощью Connector Point-а. Action без имени не обрабатываются, и выдается соответствующее сообщение об ошибке.
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 используется для написания комментариев. Его требуется присоединить к Connector Point-у на Instance. Для увеличения длины необходимо использовать Control.
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 показывает, что сигналы, поступившие в рамках данного элемента, могут приходить в разном порядке. Coregion должен быть присоединен с использованием Connector Points, в противном случае возникает ошибка
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 это блок текстовых комментариев или описаний. Может располагаться в любой части рабочего листа.
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 используется для объявления события, которое распространяется на несколько объектов (Instance). Может использоваться в качестве точки синхронизации. Необходимо задать имя или другие параметры. При использовании требуется “растянуть” на используемые оси Instance. Если условие Condition не распространяется на один из объектов (Instance), то поверх блока Condition задается instance Line:

Без Instance Line (Рис. 12‑1):


[image: image35.png]




Рис. 12‑1 Изображение Condition без Instance Line

С использованием Instance Line (Рис. 12‑2):
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Рис. 12‑2 Изображение Condition с Instance Line

Instance Line [image: image37.png]


 самостоятельно не применяется, а только совместно с блоком Condition. Для ее присоединения используем Connector Points.

Reference [image: image38.png]Refarsnce.



 применяется для определения ссылки на другую диаграмму (MPR-файл). Необходимо указать путь к используемой диаграмме. При отсутствии имени (пути) возникает ошибка
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 позволяет задавать имя блока, используется совместно с элементом Separator, который разделяет Block на 2 и более фреймов. В заглавии блока необходимо указать его название и параметры (если необходимо):

Alt – указывает, что может выполняться один из фреймов в определенной последовательности

Par – указывает, что сообщения, которые были объявлены в рамках данного блока, будут выполняться параллельно

Opt – указывает на то, что данный фрейм может использоваться опционально

Loop – указывает на то, что данный блок будет повторяться в цикле указанное число раз (указывается в параметрах)

Separator [image: image40.png]Separator



 самостоятельно не используется, применяется только совместно с элементом Block. При присоединении необходимо задействовать Connector Point.

12.2 Генерация MPR

Для генерации требуется выполнить следующие действия:

1) Установить Microsoft Visio.

2) Создать новый документ (File->New->New Drawing)

3) Загрузить Stensil для генерации mpr файлов(File->Open->MSC.VSS или File->Open Stensil ->MSC.VSS). Visio выдаст предупреждение о том, что данный stensil содержит макросы. На предупреждение следует ответить “Enable macros”

4) Нарисовать MSC – диаграмму, используя технологию Drag-And-Drop

5) Для генерации MSC вызвать следующий макрос: Tools->Macros->MSC->Module1->Parse

Возможны следующие опции генерации:
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Current Page: При использовании данной опции генерируются только текущая страница. В указанной папке будет создан MPR-файл с именем, соответствующим имени текущей страницы в Visio.

All Pages: При использовании указанной опции генерируются все страницы активного документа

Recursive Generation: При использовании данной опции имеется возможность генерации нескольких диаграмм на одной странице. Для этого необходимо нарисовать диаграмму, сгруппировать ее (Shape->Group). При этом сохраняется возможность рисовать несколько диаграмм на одной странице. По умолчанию – отключена.

Allow LOST/FOUND signals: При включении данной опции разрешается использование LOST/FOUND сигналов при проектировании MSC-диаграмм.

При отключении данной опции использование LOST/FOUND запрещается, при отсутствии connect на каких-либо сигналах выдается ошибка и mpr-файл НЕ ГЕНЕРИРУЕТСЯ.

После генерации MPR-файла вызывается программа проверки синтаксиса сгенерированного MPR-файла. Для этого используется внешняя подпрограмма MSCJUST. Для ее использования необходимо настроить в Environmental Variables переменную SIC_PATH, которая соответствовала бы пути к соответствующей программе в пакете TAT.

Для проверки правильности подключения сигналов необходимо вызвать следующий макрос Tools->Macros->MSC->Module1->Check. В случае, если какие-либо сигналы являются неподключенными, они закрашиваются красным цветом.

Используется возможность загрузки комментариев, полученных на выходе тестирующей программы. Для этого необходимо вызвать следующий макрос: Tools->Macros->MSC->Module2->OpenMPRFile. Требуется указать путь к файлу с “трассой” тестирования. После загрузки комментариев с ошибкой они выделяются красным цветом и располагаются в месте предполагаемой ошибки.

13 ConfigTAT
Программа ConfigTAT предназначена для управления процессом генерации и выполнения тестов на основе MSC-диаграмм.

При активной вкладке “Test” осуществляется настройка и запуск одного теста.
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Для генерации и запуска теста необходимо:

Указать название проекта (от него зависит одна из строк кода Wrapper)

Указать название теста (помогает различить тесты при запуске последовательности тестов)

Указать папку проекта (в нее будут помещены файлы, необходимые для генерации теста и протоколы тестирования)

Выбрать mpr-файл, задающий тест

Выбрать файл конфигурации, описывающий методы тестируемой модели

Выбрать файлы тестируемой модели

Указать путь к Wrapper-у (интерфейс между моделью и тестом)
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Указать следующие настройки:

Для макропроцессора:

Раздел в файле конфигурации (конфигурации для нескольких тестов могут находиться в одном файле)

inline loops with counter equal to <1> into plain code – преобразовывать циклы с одной итерацией в линейный код

unroll loops with constant number of iterations – разворачивать циклы с заданным числом итераций в линейный код

exclude time specifications in generated files – исключать временные спецификации из сгенерированных файлов
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Для генератора Abstract Test Suite:

active events in start – первый сигнал от теста к модели

passive events in start – первый сигнал от модели к тесту
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Для шаблона генерации теста на C#:

generate break after first error detection – завершать тест после первой же ошибки
generate instance check functionality – проверять, соответствуют ли отправитель и получатель сигнала требуемым

create log file of generation process – протоколировать процесс генерации теста

generate time processing functionality – проверять временные требования к системе
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Группа кнопок “Run” служит для запуска по отдельности или целиком этапов генерации теста и выполнения сгенерированного теста:
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Кнопка “macroprc” запускает макропроцессор

Кнопка “atsgen” запускает Abstract Test Suite генератор

Кнопка “template” запускает шаблон генерации теста на языке С#

Кнопка “C# compiler” запускает компилятор языка С# c получением на выходе файла test.exe, который представляет собой готовый к запуску тест

Кнопка “Generate whole test” последовательно запускает макропроцессор, Abstract Test Suite генератор, шаблон генерации теста на языке С# и компилятор языка С#

Кнопка “Run test” осуществляет запуск теста. Во время выполнения теста изменение всех настроек блокируется и отображается Progress Bar. Выполнение теста можно прервать нажатием кнопки “Cancel”
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Кнопка “Run ALL” осуществляет последовательно генерацию и запуск теста

Кнопка “Delete temporary files” удаляет промежуточные файлы, созданные в процессе генерации теста

Группа “Test Logs” позволяет просматривать протоколы тестирования:
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При нажатии кнопки “HTML log” в Internet Explorer отображается протокол тестирования в виде html-страницы

При нажатии кнопки “Text log” в notepad отображается протокол тестирования в виде txt файла

В listBox-е “MPR logs” отображается список протоколов в формате mpr (отдельный протокол для каждого testcase-а и каждой итерации теста), которые можно открыть в программе Telelogic нажатием кнопки “View”

С помощью кнопки “Delete logs” можно удалить все протоколы тестирования

В richTextBox-е в правой части формы отображается информация о процессе генерации и выполнении тестов. Очистить richTextBox можно с помощью кнопки “Clear”:
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Конфигурации тестов можно сохранять и открывать с помощью команд, соответственно, Save и Open меню File:
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При активной вкладке “TestSuite” осуществляется настройка и запуск набора тестов.

[image: image53.png]Test  TestSute




Кнопки “Add” и “Remove” позволяют добавлять и убирать отдельные тесты (файлы конфигурации, созданные на вкладке “Test”) из набора тестов.
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Кнопка “Run” запускает на выполнение последовательность тестов. При этом все кнопки и меню блокируются и отображается Progress Bar. 
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Остановить выполнение данного теста или всей тестовой последовательности можно с помощью кнопок “Cancel” и “Cancell ALL” соответственно.
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В richTextBox-е в правой части формы отображается краткая информация о результатах тестирования:
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С помощью пунктов “Open” и “Save” меню “File” можно, соответствено, загрузить и сохранить список тестов тестового набора.

14 SysLog Animator Manual
Эта программа предназначена для визуализации журнала системы, полученного в результате тестирования системы (см. замечание с.99).

Журнал системы представляет собой набор строчек следующего вида:

08.09.2003 15:01:29 : СИСТЕМА : Запрошен статус СКЛАДА

08.09.2003 15:01:29 : СКЛАД : Статус СКЛАДА = 16

08.09.2003 15:01:29 : СИСТЕМА : Запрошены параметры оси

08.09.2003 15:01:30 : СИСТЕМА : СКЛАДУ послана команда ПОЛОЖИТЬ В РЕЗЕРВ : 4 1 0 2 -1 -1 -1

08.09.2003 15:01:30 : ТЕРМИНАЛ ОСИ : 1 - нет данных

08.09.2003 15:01:34 : СКЛАД : 0 - команда ПОЛОЖИТЬ В РЕЗЕРВ успешно принята

08.09.2003 15:01:38 : СИСТЕМА : Запрошено сообщение от СКЛАДА

08.09.2003 15:01:38 : СКЛАД : 1 - ПОДШИПНИК успешно ПРИНЯТ: 4 1 0 2 -1 -1 -1

08.09.2003 15:01:38 : СИСТЕМА : Запрошен статус СКЛАДА

08.09.2003 15:01:38 : СКЛАД : Статус СКЛАДА = 16

Каждая строчка такого вида формируется в кадр. Кадр – Набор действий, происходящих в рамках одного события.

14.1 Внешний Вид Приложения
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14.2 Главное Меню
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File – Состоит из двух подпунктов:

Open – Открыть журнал сообщений системы.

Exit – Выйти из приложения.

Options – Состоит из одного подпункта:

Config… - Позволяет настроить толщину линий, обозначающих сигналы и задержку при анимации сигналов

Help – Состоит из одного подпункта:

About – Информация о текущей версии Log Animator-а

14.2.1 File->Open
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При выборе пункта File->Open откроется диалоговое окно, в котором можно выбрать файл, содержащий журнал сообщений системы, выделив необходимый файл среди имеющихся и нажав кнопку[image: image61.png]


. 

Если отказаться от открытия файла, необходимо нажать клавишу[image: image62.png]


.

14.2.2 File->Exit

Для выхода из приложения можно выбрать пункт меню [image: image63.png]File  Options
Open





или нажать кнопку “x” в правом верхнем углу окна.
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14.2.3 Options->Config…

Для настройки параметров визуализации нужно зайти в меню Options и выбрать подпункт Config…:
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В результате появляется диалоговое окно вида:
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Arrows Width – Устанавливает толщину линий, обозначающих сигнал.

Минимальное значение = 1. При этом линия выглядит следующим образом:
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Максимальное значение = 5. При этом линия выглядит следующим образом:
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Default значение = 2. При этом линия выглядит следующим образом:
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Arrows Time Delay – Устанавливает время вывода сигналов. Чем больше значение параметра, тем дольше будет выводиться пунктирная линия, обозначающая сигнал.

Минимальное значение = 20.

Максимальное значение = 200.

Default значение = 50.

Кнопка [image: image70.png]Cancel



 позволяет отказаться от изменения параметров и вернуться в визуализатор.

При нажатии кнопки [image: image71.png]‘ Default ‘



 значения принимают величины, предопределенные заранее. 

При нажатии кнопки [image: image72.png]


 система устанавливает  новые значения.

14.2.4 Options->Debug

Выбрав этот пункт меню, можно настроить вариант работы приложения.

Если выбран режим Debug,
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то приложение будет выводить сообщения в отладочном режиме.

Если Debug не выбран, то сообщения будут выводиться в обычном формате.
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14.2.5 Help->About

Для просмотра информации о текущей версии проекта необходимо зайти в меню Help и выбрать подпункт About:
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Появится диалоговое окно следующего вида:
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Для выхода из диалогового окна необходимо нажать кнопку[image: image77.png]


.

14.3 Анимирование кадров

Если открыть файл, содержащий журнал сообщений системы, то появится разбитый на кадры журнал. Любой кадр может быть выбран путем нажатия двойного щелчка мышки на названии нужного кадра.
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Изображение начального состояния выбранного кадра появится справа от списка кадров.
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Для работы с кадрами существует панель управления:
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Для выбора нужного кадра можно воспользоваться кнопками перемотки:
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- Выбрать первый кадр
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- Выбрать предыдущий кадр
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- Выбрать следующий кадр
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- Выбрать последний кадр

Для проигрывания кадра/кадров можно воспользоваться следующими двумя клавишами:

[image: image85.png]PLAY 1



-Проиграть 1 кадр.

[image: image86.png]PLAY ALL



- Непрерывно проигрывать все кадры, начиная с текущего и до финального. В любой момент можно прервать проигрывание, нажав кнопку[image: image87.png]


, которая появится во время проигрывания вместо кнопки [image: image88.png]PLAY ALL




Последним в списке кадров является финальное состояние (ФС).

Финальное состояние  отражает состояние системы после выполнения последнего кадра.

ФС нельзя проиграть, т.к. ФС не является кадром, а лишь отражает состояние системы в результате произошедших в системе событий.
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Здесь первая цифра обозначает номер текущего кадра, вторая – сколько всего имеется кадров.

14.4 Функционально-графическая составляющая

14.4.1 Сигналы

Сигналы в системе бывают четырех видов:

Сигнал синего цвета: 

[image: image90.png]



Означает, что идет запрос от системы.

Сигнал красного цвета:

[image: image91.png]



Означает, что ответом на запрос системы является ошибка.

Сигнал желтого цвета:

[image: image92.png]



Означает, что идет ответ на запрос системы, не содержащий никаких данных.

Сигнал зеленого цвета:

[image: image93.png]



Означает, что запрос системы выполнен успешно. Ответ положительный.

14.4.2 Объекты
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- Ось
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- Подшипник
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-Манипулятор

14.4.2.1 Ось

У оси существуют два параметра, по которым к ней подбираются подшипники:

Передний диаметр

Задний диаметр

[image: image97.png]12 12




- Здесь параметры переднего и заднего диаметров равны 12.

[image: image98.png]


- Здесь значение переднего диаметра не соответствует допустимому по FS, а значение заднего диаметра не определено.

14.4.2.2 Подшипник

Подшипник может быть изображен в трех вариантах:

[image: image99.png]


- Означает, что у подшипника не определен номер группы.

[image: image100.png]


-Означает, что у подшипника 12 номер группы.

[image: image101.png]


-Означает, что номер группы у подшипника не соответствует допустимому по FS.

15 Руководство по подготовке компьютерного класса

15.1 Требования к аппаратному и программному обеспечению

15.1.1 Необходимое аппаратное обеспечение

Intel Pentium 3 – 600 MHZ
128 Mb RAM

50 Mb Free Disk Space

Desktop Resolution 1024x768 or Higher

Desktop Colors Depth 16 Bit or Higher.

15.1.2 Необходимое программное обеспечение

Windows 2000/XP

Visual Studio .NET

MS SQL Server 2000

ActiveTCL 8.0.3 or Higher

Ms Visio 2000 or Higher

Acrobat Reader 4 or Higher

15.2 Руководство по инсталляции

Запустите программу инсталляции.
Появится диалоговое  окно.
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Для продолжения инсталляции нужно нажать кнопку NEXT.

После этого необходимо ввести путь, куда будет установлено приложение
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Следующий шаг дает информацию о пути и необходимом объеме памяти.
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Следующее диалоговое окно предлагает проверить правильность  введенной информации. Если путь набран правильно, следует нажать кнопку Install.
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После этого будет выполняться процесс установки приложения.

Продолжение процесса установки отображается с помощью прогресс бара:   
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В случае возникновения сообщения вида:

[image: image107.jpg]The operating systemis ot presently configured to runthis application.





Нажмите кнопку ОК.

После завершения копирования необходимых файлов появится диалоговое окно:
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Здесь требуется указать параметры SQL сервера.

ВНИМАНИЕ! В случае ошибочного указания параметров сервера  придется повторить инсталляцию заново.

В случае возникновения сообщения следующего вида
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необходимо нажать кнопку ОК.

При появлении сообщения:
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Необходимо нажать клавишу Enable Macros. 
Появится следующее окно:                  . [image: image111.jpg]Testing Practice - InstallShield Wizard
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После нажатия кнопки Finish инсталляция завершится. 

В результате должна появиться директория Practice, содержащая папку Documents. Файлы четырех документов MSTesting, ПрактикумMSTesting, ПрактикумFS и ПрактикумHLD, находящиеся на инсталляционном носителе рядом с файлом Set up, необходимо скопировать в папку Practice/Documents, после чего система будет готова к работе. Если документы в папке Documents сохранены в формате .doc, можно использовать все ссылки в любом документе без изменений. Если документы сохранены в формате .pdf, необходимо заменить все ссылки в документах с (../path... ) на  (Practice/Documents/path...).

15.3 Проверка инсталлированной системы
Для проверки правильности установленного пакета необходимо запустить файл run.bat, находящийся в составе инсталляционного пакета в папке SystemTesting/ScriptTests.

После завершения тестирования, когда исчезнет консольное окно, требуется запустить Пуск->Программы->Test Practice-> SysLog Animator.

В нем следует открыть log файл warehousetest0001system.log, находящийся в SystemTesting/ScriptTests/Logs, нажать PLAY ALL и   наблюдать последовательность состояний и действий системы, зафиксированную в log-файле в процессе тестирования.

Важное замечание: В папке с тестами может находиться несколько файлов с расширением .log. Только файл, имя которого содержит суффикс system (структура имени - *system.log), пригоден для просмотра в SysLogAnimator.             . 
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ПРИЛОЖЕНИЕ 1. Functional Specification


S.-Petersburg
Russia


FUNCTIONAL SPECIFICATION


		

		



		Проект:

		Учебный пример – складской комплекс



		

		



		Исполнитель

		Александр Иванов



		

		



		

		



		Продукт:

		Система управления автоматизированным комплексом хранения подшипников. 



		

		



		

		





Введение


1.1 Назначение 


Система предназначена для управления автоматизированным комплексом хранения подшипников. Она обеспечивает прием подшипников на склад, а также подбор и выдачу по запросу.


Данный документ описывает требования и ограничения на использование приложения.


1.1.1 Принятые сокращения


В настоящем документе приняты следующие определения и сокращения:


		Сокращение

		Определение



		FS

		Данный документ. Содержит технические требования, предъявляемые к программному продукту



		HLD

		High Level Design. Содержит описание модульной структуры проекта и взаимодействия его модулей



		Проект

		Проект системы управления автоматизированным комплексом хранения подшипников





В последующем течсте слово “должен” определяет необходимое требование к продукту. Слова “может”, “предполагает”, “способен” определяют направление работ, которое подлежит дальнейшему уточнению.


1.2 Обзор


1.2.1 Введение


Комплекс хранения подшипников состоит из:


1. Склада (п.1.2.2).


2. Терминала подшипника (п.1.2.3).


3. Терминала оси (п.1.2.4).


У каждого из элементов комплекса существует программа управления, реализованная в виде в dll, принимающая на вход высокоуровневые команды, и преобразующая их в управляющие воздействия для данного элемента.
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Рис. ‑1. Структура комплекса.




[image: image2.wmf]ТЕРМИНАЛ


ПОДШИПНИКА


ТЕРМИНАЛ


 


ОСИ


Принимает


,


выдает


 


и


 


хранит


подшипники


Производит


измерение


параметров


подшипника


По


 


запросу


 


от


«ТЕРМИНАЛА


ОСИ»


подшипники


выдаются


  


со


«СКЛАДА»


Производит


измерение


параметров


 


оси


Ось


Подшипник


СКЛАД


Ось


 


с


подобранными


 


и


одетыми


 


на


 


нее


подшипниками


 -


КОЛЕСНАЯ


ПАРА


Участок


 


сборки


колесной


 


пары




Рис. 1‑2 Концептуальная схема стеллажа


1.2.2 Склад


Склад предназначен для хранения подшипников. Он представляет собой стеллаж с ячейками, имеет входную и выходную ячейку и робот-манипулятор. 


Все ячейки имеют координаты – сторона стеллажа (0 или 1), ряд (0 или 1 для каждой стороны), колонка (от 0 до 4 для каждого ряда), а также порядковый номер. Выходная ячейка имеет номер 999 и координаты (9,9,9), а приемная – 0 и координаты (0,0,0). Всего  ячеек, кроме приемной и выходной, 20 штук. 


Стеллаж имеет две области ячеек: рабочую и резервную (Рис. 1‑2). В рабочей области хранятся опознанные подшипники, т.е. подшипники для которых были получены параметры с терминала подшипника и операция по перемещению в ячейку для которых была закончена успешно. В резервную область попадают неопознанные подшипники, т.е. подшипники при операциях с которыми произошел сбой и нельзя гарантировать достоверность полученных для них параметров.


Как в рабочей так и в резервной областях могут существовать сбойные ячейки. Ячейка  помечается как сбойная, если робот-манипулятор не может взять из нее подшипник или если он не может положить подшипник в эту ячейку. Каждая ячейка может быть помечена  либо как занятая, либо как свободная, либо как сбойная.
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Рис. 1‑3. Схема стеллажа.


1.2.2.1 Статус склада


Склад может иметь в каждый момент времени один из следующих статусов:


Табл. 1‑1. Статус склада.


		Код

		Значение



		32

		Подшипник во входной ячейке



		16

		Подшипник в манипуляторе



		4

		Нет нуля 



		0

		Склад свободен
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Рис. 1‑4. Граф переходов статусов склада.


1.2.2.2  Список команд складу


Склад принимает следующие команды: 


Табл. 1‑2. Список команд складу.


		№

		Код

		Название

		Полное название команды



		1

		1

		GetR

		Получить из входной ячейки  



		2

		2

		SendR

		Отправить из ячейки в выходную ячейку



		4

		4

		PutR

		Положить в резерв



		5

		6

		SetN

		Произвести зануление 



		7

		20

		Term

		Завершение команд выдачи





1.2.2.3  Формат команд складу


Команды имеют формат:


Табл. 1‑3. Формат команд складу.


		№

		Параметр

		Тип

		Диапазон допустимых значений

		Описание



		1

		NameCommand

		int

		1…6,9,10,20

		Название команды (Табл. 1‑2)



		2

		TagSt

		int

		0…1

		Сторона результирующей ячейки



		3

		TagCol

		int

		0…4

		Колонка результирующей ячейки



		4

		TagRow

		int

		1…2

		Ряд результирующей ячейки



		5

		SourseSt

		int

		0…1

		Сторона исходной ячейки



		6

		SourseCol

		int

		0…4

		Колонка исходной ячейки



		7

		SourseRow

		Int

		1…2

		Ряд исходной ячейки





Табл. 1‑4. Сообщения от склада в ответ на посылку команды.


		№

		Код

		Описание



		1

		-4

		Нет свободных ячеек



		2

		-3

		Не послать



		3

		-2

		Тайм аут



		4

		-1

		Нет клиента



		5

		0

		Успешное получение команды



		6

		1

		Ошибка при получении команды



		7

		2

		Склад не понял команду



		8

		3

		Склад занят





Табл. 1‑5. Статус обмена со складом.


		№

		Код

		Описание



		1

		-3

		Нет обмена



		2

		-2

		Тайм аут



		3

		-1

		Нет клиента



		4

		0

		Возвращаемый параметр mParametr содержит статус склада 



		5

		1

		Нет данных





Табл. 1‑6. Сообщение от склада.


		№

		Код

		Описание



		1

		-1

		Нет склада



		2

		0

		Нет сообщения



		3

		1

		Команда выполнена без ошибки



		4

		2

		Команда выполнена с ошибкой. Не удается взять подшипник из заданной ячейки.



		5

		3

		Команда выполнена с ошибкой. Не удается положить подшипник в заданную ячейку.





1.2.3 Терминал подшипника


Производит измерение параметров подшипника. В ответ на запрос системы возвращает одно из следующих сообщений: 


Табл. 1‑7. Статус обмена с терминалом подшипника.


		№

		Код

		Описание



		1

		-3

		Нет обмена



		2

		-2

		Тайм аут



		3

		-1

		Нет клиента



		4

		0

		Структура с измеренными параметрами подшипника в буфере



		5

		1

		Нет данных





В случае сообщения с кодом = 0 в буфере находится структура со следующими параметрами подшипника:


Табл. 1‑8. Параметры подшипника.


		№

		Название

		Тип 

		Диапазон допустимых значений

		Описание



		1

		NameMaster

		String

		Любая строка длиной до 255 символов

		ФИО мастера, производившего измерения



		2

		Factory

		String

		Любая строка длиной до 255 символов

		Название депо



		3

		ShiftNum 

		Byte

		1...2

		Номер рабочей смены 



		4

		Number

		String

		Любая строка длиной до 255 символов

		Номер подшипника



		5

		GroupNum

		Int

		12...20

		Номер группы подшипника



		6

		Septype

		byte

		0…1

		Тип сепаратора подшипника



		7

		AShift

		Float

		0.01…1

		Осевой сдвиг





1.2.4 Терминал оси


Производит измерение параметров оси. В ответ на запрос системы возвращает одно из следующих сообщений: 


Табл. 1‑9. Статус обмена с терминалом оси.


		№

		Код

		Описание



		1

		-3

		Нет обмена



		2

		-2

		Тайм аут



		3

		-1

		Нет клиента



		4

		0

		Структура с измеренными параметрами оси в буфере



		5

		1

		Нет данных





В случае сообщения с кодом = 0 в буфере находится структура со следующими параметрами оси:


Табл. 1‑10. Параметры оси.


		№

		Название

		Тип

		Диапазон допустимых значений

		Описание



		1

		NameMaster

		String

		Любая строка длиной до 255 символов

		ФИО мастера, производившего измерения



		2

		ShiftNum

		Byte

		1…2

		Номер рабочей смены



		3

		Factory

		String

		Любая строка длиной до 255 символов

		Название депо



		4

		ANumber

		Int

		Любая строка длиной до 255 символов

		Номер оси



		5

		Side 

		Byte

		0…1

		Сторона оси 0-правая, 1-левая 



		6

		BackDiam

		Float

		12...20

		Посадочный диаметр задний



		7

		FrontDiam

		Float

		12...20

		Посадочный диаметр передний





2 Интерфейсы взаимодействия системы
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Рис. 2‑1. Интерфейсы системы.


2.1  Интерфейс со складом (Store.dll)


Для получения сообщения от склада:


static public long GetStoreMessage(). Возвращаемые значения описаны в Табл. 1‑6.


Для получения статуса склада:


static public int GetStoreStat(out long mParametr). Возвращаемые значения описаны в Табл. 1‑5. Значения принимаемые возвращаемым параметром mParametr описаны в Табл. 1‑1.


Для посылки команды складу:


static public int SendStoreCom (int NameCommand, int TagSt, int TagCol, int TagRow, int SourseSt, int SourseCol, int SourseRow), Возвращаемые значения описаны в  Передаваемые параметры описаны в Табл. 1‑3.


2.2  Интерфейс с терминалом подшипника (Bearing.dll)


Для получения сообщения от терминала подшипника система должна вызывать следующую функцию модуля Bearing.dll:


static public int GetRollerPar(out string NameMaster, out string Factory, out string Number, out byte  ShiftNum, out int  GroupNum, out byte  SepType, out float AShift) 


Функция  должна возвращать одно из значений перечисленных в Табл. 1‑7. Возвращаемые параметры описаны в Табл. 1‑8. 


2.3  Интерфейс с терминалом оси (Axle.dll)


Для получения сообщения от терминала оси система должна вызывать следующую функцию модуля Axle.dll:


static public int GetRollerPar(out string NameMaster, out string Factory, out string Number, out byte  ShiftNum, out int  GroupNum, out byte  SepType, out float AShift) Функция  должна возвращать одно из значений перечисленных в Табл. 1‑9. Возвращаемые параметры описаны в Табл. 1‑10.


3 Специфические требования


Система управления комплексом должна:


1. Произвести опрос статуса склада (вызвать функцию GetStoreStat). Добавить в журнал сообщений запись «СИСТЕМА : Запрошен статус СКЛАДА». В зависимости от полученного значения произвести следующие действия:


a. Полученный статус склада = 32. В приемную ячейку склада поступил подшипник. Система должна:


i. Добавить в журнал сообщений запись «СКЛАД : Статус СКЛАДА = 32». 


ii. Получить параметры поступившего подшипника с терминала подшипника (должна быть вызвана функция GetRollerPar). 


iii. Добавить в журнал сообщений запись «СИСТЕМА: Запрошены параметры подшипника».


iv. В зависимости от статуса терминала подшипника (возвращенного функцией GetRollerPar значения)  должны быть выполнены следующие действия:


Табл. 3‑1 Действия зависимости от статуса терминала подшипника. 


		№

		Статус терминала подшипника

		Действия системы



		1

		-3

		Добавить в журнал сообщений запись «ТЕРМИНАЛ ПОДШИПНИКА: -3 – нет обмена»



		2

		-2

		Добавить в журнал сообщений запись «ТЕРМИНАЛ ПОДШИПНИКА: -2 – таймаут»



		3

		-1

		Добавить в журнал сообщений запись «ТЕРМИНАЛ ПОДШИПНИКА: -1 – нет клиента»



		4

		0

		1. Добавить на первое место команду GetR - «ПОЛУЧИТЬ ИЗ ПРИЕМНИКА В ЯЧЕЙКУ»


2. Добавить в журнал сообщений запись «ТЕРМИНАЛ ПОДШИПНИКА: 0 - параметры возвращены <Номер_группы>»



		5

		1

		Добавить в журнал сообщений запись «ТЕРМИНАЛ ПОДШИПНИКА: 1 – нет данных»



		6

		Другое

		Добавить в журнал сообщений запись «ТЕРМИНАЛ ПОДШИПНИКА: ОШИБКА : Неопределенный статус»





b. Полученный статус склада = 16. Склад свободен, т.е. не выполняет никаких команд, но при этом в манипуляторе находится подшипник.  В этом случае складу система должна:


i. Добавить в журнал сообщений запись «СКЛАД : Статус СКЛАДА = 16». 


ii.  Поставить на первое место в очереди команду PutR - «ПОЛОЖИТЬ В РЕЗЕРВ».


c. Полученный статус склада = 4. Нет нуля. В этом случае складу система должна:


d. Добавить в журнал сообщений запись «СКЛАД : Статус СКЛАДА = 4». 


i.  Поставить на первое место в очереди команду SetN – «ПРОИЗВЕСТИ ЗАНУЛЕНИЕ».


e. Полученный статус склада = 0. Склад свободен. Никаких действий в ответ на этот статус система предпринимать не должна.


f. При любом другом статусе в журнал должно быть добавлено сообщение «СКЛАД : ОШИБКА : Неопределенный статус».


2. Произвести опрос терминала оси (вызвать функцию получения сообщения от терминала - GetAxlePar). В журнал сообщений должно быть добавлено сообщение «СИСТЕМА: Запрошены параметры оси». В зависимости от статуса терминала оси (возвращенного функцией GetAxlePar значения)  должны быть выполнены следующие действия:


Табл. 3‑2 Действия зависящие от статуса терминала оси


		№

		Статус терминала оси

		Действия системы



		1

		-3

		Добавить в журнал сообщений запись «ТЕРМИНАЛ ОСИ: -3 – нет обмена»





		2

		-2

		Добавить в журнал сообщений запись «ТЕРМИНАЛ ОСИ: -2 – таймаут»



		3

		-1

		Добавить в журнал сообщений запись «ТЕРМИНАЛ ОСИ: -1 – нет клиента»



		4

		0

		1. Добавить в журнал сообщений запись «ТЕРМИНАЛ ОСИ: 0 - параметры возвращены <Передний_диаметр> < Задний_диаметр>»


2. Подобрать два подшипника из имеющихся на складе в соответствии со следующими требованиями:


a. Они должны находиться в ячейках с разными номерами.


b. Разность группы первого подшипника и группы  переднего посадочного диаметра оси (FrontDiam) должна быть меньше либо равна 2.


c. Разность группы второго подшипника и группы  заднего посадочного диаметра оси (BackDiam) должна быть меньше либо равна 2.


d. Разность разностей пункта ii. и iii. Должна быть меньше либо равна 2.


e. Выдаваемые подшипники должны иметь одинаковый тип сепаратора.


f. В первую очередь должны выдаваться подшипники, которые находятся на складе дольше всего. 


3. При успешном подборе подшипников:


a. В журнал сообщений должно быть добавлено сообщение «ТЕРМИНАЛ ОСИ : ПОДШИПНИКИ  подобраны»


b. В конец очереди команд должны быть добавлены две команды «SendR Отправить ячейку на выход» с параметрами подобранных подшипников, а также завершающая выдачу команда «Term Завершение команд выдачи». 


4. При отсутствии на складе подшипников, удовлетворяющих заданным параметрам,  в журнал должно быть добавлено сообщение «ТЕРМИНАЛ ОСИ : Не подобрать ПОДШИПНИОВ».



		5

		1

		Добавить в журнал сообщений запись «ТЕРМИНАЛ ОСИ: 1 – нет данных»



		6

		Другое

		Добавить в журнал сообщений запись «ТЕРМИНАЛ ОСИ: ОШИБКА : Неопределенный статус»





3. При поступлении команды в очередь система  должна  отправить команду на выполнение складу (параллельно с продолжающимся опросом терминала оси) и в зависимости от возвращенного функцией посылки команды статуса команды, выполнить следующие действия (Табл. 1‑4):

a. Полученный статус: 0 – успешное получение команды. В журнал сообщений дложно быть добавлено сообщение «СКЛАД : 0 – команда <Полное_название_команды> успешно принята». Команда должна быть удалена. Система должна получить сообщение от склада о результатах выполнения команды (п.1.3 пункт 4).


b. Полученный статус: 1 – при посылке  команды произошла ошибка. В журнал сообщений дложно быть добавлено сообщение «СКЛАД : 1 – ошибка при посылке команды <Полное_название_команды>». Команда должна быть удалена.


c. Полученный статус:  2 - склад не понял команду. В журнал сообщений должно быть добавлено сообщение «СКЛАД : 2 – склад не понял команду <Полное_название_команды>». Система должна попытаться послать команду повторно, после второй неудачной попытки в журнал должно быть добавлено сообщение «СКЛАД : Не понял команду после двух попыток», команда должна быть удалена, а система должна приступить к выполнению следующей в очереди команды, если очередь не пуста.


d. Полученный статус:  3 – склад занят. Система должна посылать команду в течение 30 секунд, при истечении данного интервала в журнал должно быть добавлено сообщение об ошибке «СКЛАД : 3 - занят более 30 секунд», команда должна быть удалена, а система должна приступить к выполнению следующей в очереди команды, если очередь не пуста.


e. Полученный статус:  -1 - нет склада. Система должна попытаться выполнить команду повторно, после второй неудачной попытки в журнал должно быть добавлено сообщение «СКЛАД : -1 - нет СКЛАДА» и система должна завершить работу.


f. Полученный статус: -2 - таймаут. Система должна попытаться выполнить команду повторно, после второй неудачной попытки в журнал должно быть добавлено сообщение «СКЛАД : -2 - таймаут при посылке команды» и система должна завершить работу.

g. Полученный статус:  -3 - не послать. Система должна попытаться выполнить команду повторно, после второй неудачной попытки в журнал должно быть добавлено сообщение «СКЛАД : -3 - не удается послать команду СКЛАДУ» и система должна завершить работу.

h. Полученный статус:  -4 - нет свободных ячеек. В  журнал должно быть добавлено сообщение «СКЛАД : -4 - нет свободных ячеек», команда должна быть удалена, а система должна приступить к выполнению следующей в очереди команды, если очередь не пуста.


i. При получении любого другого статуса в журнал должно быть добавлено сообщение «СКЛАД : ОШИБКА : Неопределенный статус при посылке команды».

4. После успешного получения складом команды (получения статуса команды = 0  (п.1.3 пункт 3))  система должна получить сообщение от склада и добавить в журнал сообщение «СИСТЕМА : Запрошено сообщение от СКЛАДА»:

a. Полученное сообщение:  -1 -  нет склада. Система должна попытаться получить сообщение повторно, после второй неудачной попытки в журнал должно быть добавлено сообщение «СКЛАД : -1 - нет СКЛАДА» и система должна завершить работу.


b. Полученное сообщение:  0 -  нет сообщения. Это означает, что склад еще занят, следует продолжать опрос.

c. Полученное сообщение:   1  - Команда выполнена без ошибки. 

d. На первое место в очередь должна быть добавлена команда с параметрами удаленной команды, но номер результирующей ячейки в команде должен быть заменен номером другой свободной ячейки, соответственно алгоритму поиска свободной ячейки.


e. Полученное сообщение: 2 - Команда выполнена с ошибкой, не удается взять подшипник. Если текущая выполняемая команда:


i.  GetR - «Получить из приемника в ячейку»:


1. В  журнал должно быть добавлено сообщение «СКЛАД : ОШИБКА : Не взять из входной ячейки».



2. Текущая команда должна быть удалена.


3. На первое место в очереди должна быть добавлена команда SetN – «Произвести зануление».


ii.  SendR – «Отправить ячейку на выход» :


1. В журнал должно быть добавлено сообщение «СКЛАД : Не взять из ячейки <Номер_ячейки>».


2. Текущая команда должна быть удалена.


3. На первое место в очереди должна быть добавлена команда SetN – «Произвести зануление».


4. На второе место в очереди должна быть добавлена команда SendR – «Отправить ячейку на выход» с параметрами удаленной в п.2 команды.


5. При получении того же статуса при повторной попытке выполнения команды SendR:


a. Ячейка должна быть помечена как сбойная (не должны предприниматься дальнейшие попытки положить в нее подшипники)


b. В журнал должно быть добавлено сообщение «СИСТЕМА : Ячейка <Номер_Ячейки> <Номер_Стороны> <Номер_Колонки> <Номер_Ряда> помечена как сбойная»


c. Текущая команда SendR должна быть удалена.


d. На первое место в очередь должна быть добавлена команда с параметрами удаленной команды, но номер результирующей ячейки в команде должен быть заменен номером другой свободной ячейки, соответственно алгоритму поиска свободной ячейки.


f. Полученное сообщение: 3 - команда выполнена с ошибкой, не удается положить подшипник. Если порядковый номер результирующей ячейки:


i. 999, т.е. это выходная ячейка, то:


1. В журнал должно быть добавлено сообщение «СКЛАД : Не могу положить подшипник в выходную ячейку».


2. Текущая команда должна быть отложена.


3. Должна быть выполнена команда SetN – «Произвести зануление»


4. Должна быть произведена попытка выполнить отложенную команду.


5. При получении того же статуса при повторной попытке выполнения команды:


a. Текущая команда должна быть удалена


b. В  журнал должно быть добавлено сообщение «СКЛАД : Не могу положить подшипник в выходную ячейку после второй попытки».


ii. Любой другой кроме 999 и 0, то:


1. В журнал должно быть добавлено сообщение «СКЛАД : Не могу положить подшипник в ячейку № <Номер_ячейки>».


2. Текущая команда должна быть удалена.


3. На первое место в очереди должна быть добавлена команда SetN – «Произвести зануление».


4. На второе место в очереди должна быть добавлена команда с параметрами удаленной в п.2 команды.


5. При получении того же статуса при повторной попытке выполнения команды:


a. Ячейка должна быть помечена как сбойная (не должны предприниматься дальнейшие попытки положить в нее подшипники)


b. В журнал должно быть добавлено сообщение «СИСТЕМА : Ячейка <Номер_Стороны> <Номер_Колонки> <Номер_Ряда> помечена как сбойная»


c. Текущая команда должна быть удалена.


d. На первое место в очередь должна быть добавлена команда с параметрами удаленной команды, но номер результирующей ячейки в команде должен быть заменен номером другой свободной ячейки, соответственно алгоритму поиска свободной ячейки.


5. После опроса терминала оси система должна обработать все добавленные в очередь команды и после этого продолжить свое выполнение начиная с пункта 1.
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